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ÖNSÖZ 

Dünya’da ve Türkiye’de teknolojinin ilerlemesi ile bu 
değişimden en çok etkilenen sektörlerin başında basım 
sektörü gelmektedir. Her yıl çıkan piksel ve vektörel 
tabanlı programların ileri sürümlerini anlatan mevcut 
kitapların tercümeden öteye pek de fazla gittiği 
söylenemez. Bundan dolayı 26 yıllık tecrübeme 
dayanarak ve 2004’ten beri öğretim görevlisi olarak 
verdiğim eğitimler sonucunda var olan eksikliği biraz 
olsun gidermek ve tasarıma başlayanları yönlendirmek 
amacıyla bu kitabı yazmaya karar verdim.  

Kitabın ilk bölümünde Masaüstü Yayıncılık ile ilgili 
bilmesi gereken teknik bilgiler verilmektedir. İkinci 
bölümde Masaüstü Yayıncılığın tanımı yapılmakta ve 
üçüncü bölüm itibarı ile küçük ve orta ölçekli 
işletmelerde en çok kullanılan ve ktörel program 
CorelDraw anlatımı başlamaktadır. Kitabın beşinci 
bölümünde ise kitabın diğer bölümlerinde verilen bilgiler 
doğrultusunda uygulama örnekleri verilmektedir.  

Kısa zamanda çok iş gerçekleştirmek zorunda olan 
Reklam Ajanslarında ve basım sektöründe çalışan veya 
eğitim alan tüm elemanlara ve öğrencilere yardımcı 
olması dileği ile hepinize başarılar dilerim. 
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GİRİŞ 

Tasarım dünyasında vektörel tabanlı bir program olarak 
bildiğiniz Coreldraw programı Grafikerlerin kolayca 
tasarım yapabildikleri vazgeçilmez bir programdır. 
Birçok büyük Gazete Dergi gibi Matbaa Firmaları, 
Reklam ajansları, Tekstil sektörü Coreldraw programı ile 
çalışmaktadır. Genelde coreldraw ve photoshop birbirine 
çok benzerler aralarındaki fark birinin Vektorel diğerinin 
Pixel tabanlı olmasıdır. Coreldraw gibi vektörel 
progamlarını pixel tabalı programlardan ayıran en büyük 
özellik nokta tabanlı olmasıdır. Örneğin bir Logo 
oluştururken vektörel bir grafik programı kullanmakta 
fayda vardır. Coreldraw’un size sunduğu kolaylıkları ve 
marifetleri saymakla bitmez. Bu kitapta programı 
anlatırken uygulama örnekleri ile sizlere yol 
gösterilmektedir. 
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BİRİNCİ BÖLÜM 
1. TEMEL BİLGİLER 

Vektörel tabanlı bir program olan CorelDraw matbaa ve 
tasarım sektöründe olduğu kadar tekstil sektöründe de 
oldukça yoğun kullanılan bir programdır.  

Bu programda; Bir firmaya ait tüm kurumsal kimlik 
çalışmaları; Logo, amblem, logotype, dosya, kartvizit, 
antetli kağıt, zarf vb., el broşürü, katalog, şablon, insert 
çalışmaları yapabilirsiniz. Ayrıca; etiket, ambalaj, kesim 
için bıçaklar hazırlayabilir, montaj yapabilirsiniz. 

Kendi doku ve desenlerinizi çizebilir, fotoğraf efektleri 
verebilirsiniz. Fotoğraflarınızı vektöre çevirerek 
kendinize has çalışmalar yapabilirsiniz. Macro seçeneğini 
kullanarak çok kısa bir süre de takvim hazırlayabilirsiniz.   

Vektörel Çizim: Matematiksel eğrilerle çizilmiş, istenilen 
boyuta getirebilen çizimlerdir. Vektörel nesnelerin baskı 
kalitesi, bir fotoğrafın (piksel) kalitesine göre çok daha 
fazladır. Piksel çizime göre daha az yer kaplar. Ayrıca 
yaptığınız her türlü tasarımı çözünürlüğü bozulmadan 
istediğiniz boyutta alabilirsiniz.  Bina giydirme, araç 
giydirme, halı deseni çizme vb. işlerde kolaylıkla 
kullanabilirsiniz.  
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1.1. Masaüstü Yayıncılık Donanımı (Çevre 
Birimleri) 

 Bilgisayar: Verilerin üstünde işlem yaparak 
okunabilir ve görüntülenebilir hale getiren 
teknolojik makineler 

 Bilgisayardan Baskıya Sistemleri: Bu sistemde 
bilgisayarda hazırlanan bir iş, direk olarak kalıba 
pozlanır ve arkasından baskıyı gerçekleştiren bir 
sistemdir. Bunun kolaylığı montaj ve kalıphane 
probleminin kaldırmaktır.  

 CCD (Changed Coupler device- Yüklü Kuplaj 
aygıtı): CCD, tarayıcılar ve dijital kameralar gibi 
cihazlarda ışığı ölçmek için kullanılan elektronik 
bir aygıttır. 

 Digital Fotoğraf Makinesi (Giriş Ünitesi): 
Resimleri kendi bünyesinde direk 
sayısallaştırabilen ve bu görüntüleri bilgisayar 
ortamına aktarabilen fotoğraf makinesi çeşidi.  

 Harici Kayıt Birimi (SCSI, cd-w-çıkış ve giriş 
ünitesi):Sabit disk gibi bilgileri hafızasında 
tutabilen fakat sabit olmayıp taşınabilen ve başka 
bir bilgisayara bağlanabilerek kopyalanmasını ve 
taşınabilerek diğer bilgisayar ortamlarına 
aktarılmasını sağlar.  
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 Klavye (girdi ünitesi):Bilgisayarda, daktilo gibi 
yazıp, resimler üzerinde ve veriler üzerinde 
değişiklik yapmanıza olanak tanıyan parça. 

 Modem (çıkış ve giriş ünitesi): 
 Mouse (fare-girdi ünitesi):Bilgisayar 

yazılımlarında seçme, kopyalama, kesme, 
çizme… vb. gibi işlemleri yapan, bilgisayarın 
ünitesi.  

 Kalem mouse: Bir nevi tarayıcı gibi işlem yapan, 
daha önceden çizilmiş nesnenin üstünden geçerek 
çizime yardımcı olan yada elle serbest çizim 
yaparak görüntü oluşturmaya yarayan cihaz. 

 Printer (yazıcı- çıktı ünitesi):Bilgisayar 
ortamında üretilen yazılı ve görsel materyallerin 
kâğıt üzerine aktarılmasını sağlayan digital aygıt. 
Masaüstü yayıncılık donanımının en temel 
üyelerinden birisi. Renkli ve siyah beyaz, nokta 
esaslı, mürekkep püskürtmeli ve laser sistemiyle 
çalışan çeşitleri vardır. 

 Scanner (girdi ünitesi):Basılmış olan yazı ve 
resim gibi görüntüleri, 0 ve 1 kodları ile 
sayısallaştırarak bilgisayar ortamına aktarılan 
parça.  

 El tarayıcıları; Daha ufak boyutlu (barkod 
okuyucusu gibi) 

 Tamburlu tarayıcılar; reprodüksiyon 
atölyelerinde daha detaylı ve kaliteli tarama 
yapan cihazlardır. Genellikle yerinden 
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çıkartılabilen saydam bir silindir (tambur) üzerine 
montelenmiş bir görüntüyle iş görürler. 
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İKİNCİ BÖLÜM 
2. MASAÜSTÜ YAYINCILIK NEDİR? 

(Kitap, dergi, gazete, broşür gibi yayınları kişisel 
bilgisayarlarda özel yazılımlar kullanarak hazırlama 
yöntemi). 

2.1. MÜY YAZILIMLARI 

 A. Nokta esaslı (bitmapped): Yumuşak ve 
resimsel efektler için idealdirler. Bu programda 
oluşturulan görüntüler pixel noktacıklarından 
oluşur. Nokta esaslı tasarım programları şöyle 
sıralanabilir: Adobe Photoshop, Fractal Design 
Painter, Fractal Design Color studio, Aldus 
SuperPaint. 

 B. Nesne esaslı (objectorinented): 

 Vektörel tabanlı programlar olarak da anılan bu 
yazılımlarda geometrik çizim, simge, logo ve 
diğer tipografik uygulamalar için gereken düzgün 
ve keskin kenarlı görüntüler üretilir. Bu 
programlar bütün imgeleri nokta yerine, çizgi ya 
da vektörler halinde depolar. Bu programlar 
arasında en yaygınları; Aldus Freehand ve Adobe 
Illustrator. 
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Adobe systems: Postscript dili, Adobe Illustrator, Adobe 
Photoshop, Adobe acrobat gibi geniş bir yazıtipi 
yelpazesi ile profesyonel grafik sanatçıları ve 
iletişimcileri için tasarlanan diğer araçların 
yazılmasından sorumlu şirketin adı. 

Baskı provası: Bir işin, basıldığı zaman nasıl 
görüneceğini kestirme yöntemi, prova son çoğaltmada 
kullanılacak olan gerçek kağıt, mürekkep setleri ve 
görüntüleri ile çalışan baskıdan alınan bir örnektir. 
Zeroks çıktısı kullanılabilir (müşteriye tanıtım için). 

Clip art: Tasarımcıların kesip çıkartmaları ve 
tasarımlarına yapıştırmaları için kağıda basılmış 
resimlemelerdir. Masaüstü yayıncılığıyla, clip art 
diskketten kopyalanabilen ve diğerine yapıştırılabilen, 
kaydedilen elektronik resimlerdir. 

Çözünürlük: Bir görüntünün piksellerle ölçülen eni ve 
boyudur. Buna bağlı olarak yüksek çözünürlüklü görüntü 
denildiğinde çözünürlüğü, çoğaltılacağı çizgili ekranın en 
az iki katı olan görüntü anlaşılır. Örneğin 150 çizgilik bir 
ekrana basılan 300-dpi görüntü yüksek çözünürlüklüdür. 

Dpi: Bir inç’teki tarama sayısıdır. Bir inçteki tarama 
sayısı arttıkça görüntü daha detaylı taranır ve kaliteside 
artar.  

En düşük 72 dpi , en yüksek 1200 dpi 
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Lpi (Lines Per Inch): Inç başına düşen satır sayısına 
masaüstü yayıncılıkta verilen isim. Bir lazer yazıcıdan 
basılacak olan fotoğraflar 75 Lpi’ya kadar 
çıkabilmektedir. Gerçekten kaliteli ise Lpi değeri 500’e 
kadar çıkabilmektedir. 

Piksel (Nokta):  Tek resim elemanı. Ekranda yada 
sürekli tonlu bir görüntüde birtek nokta, bilgisayar 
monitörünün görüntüleyebileceği en küçük nokta. 

Densitometre: Bir sayfa üzerindeki mürekkebin 
yoğunluğunu veya bir görüntünün belirli bir bölgesinin 
yoğunluk değerlerini ölçmek için tasarlanmış bir alet 
(Renk yüzdesini ölçer). 

High-key görüntü: Çok işleme maruz kalmış, soluk bir 
görüntü veya tarama işlemi sırasında detayları kaybolmuş 
bir görüntü. 

HSL (Hue, Saturation and lightness- Renk doyma ve 
aydınlık): Doyma rengin derecesini ve tonunu; aydınlık 
ise o renkte ne kadar beyaz olduğunu gösterir. 

İthal etmek: Başlıca bir uygulamada üretilen bir 
görüntüyü, farklı bir uygulamada okumak. Mesela 
freehand programında üretilen bir görüntüyü uygun 
formatta kaydedip photoshop programında okutabilmek. 

Katman: Nesnelerin, görüntünün bütününü etkilemeden, 
ayrı düzlemler üzerine yerleştirilip düzeltilebilmesine 
imkân veren bir yöntem. 
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Kesmek: Bir görüntünün ya da yazının seçilmiş bir 
kısmının çıkartıp panoya kopyalamak 

Kontrast: Bir görüntünün en parlak ve en karanlık 
alanları arasındaki ilişki. 

Lüminans: Bir tonun, rengine veya doymasına 
bakmaksızın, parlaklık veya aydınlığının bir ölçüsü. 

Madde imleri: Listelerdeki maddeleri sunmak amacıyla 
kullanılan tasarımsal semboller. 

Maske: Bir nesnenin bir kısmını korumak veya yerinden 
çıkarmak için yaratılan başka bir nesne. Maskeyi bir 
şablon gibide düşünebiliriz.   

Nokta Kazancı: Bir yarımton noktasının, görüntünün 
üzerine basıldığı kâğıdın mürekkep soğutması nedeniyle 
genleşmesi.  

Gazete baskısının nokta kazancı çarpanı büyüktür, buna 
karşın yaldızlı kâğıtların nokta kazancı çarpanları 
küçüktür.  

NOT: Çözünürlük ne kadar fazla ise kalitede o seviyede 
iyi olur. 

Nokta Şekli: Bir yarımton noktasının şekli (yuvarlak, 
kare, baklava vb.) Adobe Photoshop, herbiri basılmış 
görüntünün üzerinde farklı etkilere sahip olan birçok 
nokta şekli obsiyonu sunmaktır. 
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Bilgisayarın internete ulaşmasını sağlayan parça. 

Monitör (Çıktı ünitesi): Bilgisayardaki verileri 
görüntülemeye yarayan araç. 

Nokta : Tek bir yarımton elemanı 

Opak : Tüm ışığı tutan bir ton (%100 siyah). Saydam 
olmayan, ışığı geçirmeyen fotoğraf nasıl gözükeceğini 
gösteren yazılım fonksiyonu. 

Ön izleme: Bir dökümanın yazıcıdan nasıl çıkacağını ya 
da ayarlanmış kağıt tipinde nasıl gözükeceğini gösteren 
yazılım fonksiyonu 

Pano: Belleğin sıralı geçici depolama için kullanılan 
alanı. Panoya herbilgi kopyalanışında bir önceki 
kopyalanan silinir. 

Pikselleştirme: Pikselleri ayrı ayrı görünür kılmak 
amacıyla, görüntünün çözünürlüğünü azaltarak sağlanan 
özel efekt. 

Renk Ayrımı: Bir görüntüyü, baskıda çoğaltmak üzere 
dört işlem mürekkep renklerine çevirme işlemi 

Rötuşlama : Dijital bir görüntünün, piksel değerlerini 
ayarlamak için tasarlanmış araçlarla değiştirilmesi, 

RSI : Tekrarlamalı zorlanma sakatlığı. Doktorlar RSI 
denen bir rahatsızlığın her gün klavye ve fare ile 
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çalışmaktan kaynaklanabileceğini düşünüyor. Bu hastalık 
en çok bilekleri, parmakları ve kolu etkiliyor. 

Saydamlık : Işığın yüzeyinden geçmesine izin veren 
bir malzeme üzerindeki bir görüntü; bir görüntümün 
altındaki görüntüleri gösterebilme yeteneği. 

Sürekli ton : Yarım ton noktaların ayrılması ve 
dönüştürülmesinden önceki dijital görüntü. 

Şablon: Bitirilmeye hazır bir dökümanın bütün 
özelliklerini içeren salt okunur bir dosya. Şablonlar 
genelde yayınlarda isim plakaları ve adres  bölgeleri gibi 
değişmeyen parçaları, sütun yapısı ve sayfa düzeni gibi 
özellikleri içerir. Şablonlar zamandan tasarruf etmemizi 
sağlar. 

Taramak : Opak ya da saydam orijinalleri, tasarımlarda 
kullanılabilecek sayısal dosyalara dönüştürme işlemi. 
Tarama işlemi amacına göre, masaüstü ya da tamburlu 
tarayıcılarda gerçekleştirilebilir. 

True Type: Apple ve Micrsoft tasarımcılar tarafından 
evrensel olarak kabul edilmiş yazıtipi düzeni. Gelişmiş 
hizmet büroları daha çok bu yazıtipini tercih eder. 

Vektör Görüntü: İçindeki nesnelerin piksellerle değil, 
matematiksel olarak tanımlı oldukları görüntü. 
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2.2. Masaüstü Yayıncılıkta Kullanılan Format 
      Çeşitleri 

TIFF: (tagged Image File Format-Etkiletlenmiş Görüntü 
Dosya Formatı) aldus corporation tarafından bit-eşlemli 
görüntüleri depolamak için yaratılan bir dosya formatı. 

PDF: (Adobe Acrobat’ın Portable Document bütün biçi 
özellikleri dosyaya kaydediliği için platformlar arası 
taşımada sorun olmaz). 

PICT: Birçok program tarafından kullanılan bir dosya 
formatı. Pekçok multimedya uygulaması ekranda grafik 
göstermede pict formatı kullanılır. 

JPEG: Jpint Picture Experts Group tarafından yaratılmış, 
dosyalının orijinal boyutunu küçülten bir sıkıştırma 
metodu (diğerlerine göre kalitesiz görünebilir çünkü 
küçültülmüştür). 

EPS: (Encapsulated Postscript) Grafik ve görüntü 
dosyalarını depolamak için Adobe system tarafından 
geliştirilen EPSF de denilen bir dosya biçemi standardı  

2.3. RENK 

24-bit renk: Her renk kanalı (kırmızı, yeşil, mavi) için 
256 renk tonu sunan renk modeli 

32-bit renk: Her renk kanalı (kırmızı, yeşil ve mavi) için 
256 renk tonu ile birlikte 256 tonlu bir de maskeleme 
kanalı sunan renk modeli. 
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8-bit renk: 256 (renkli bir monitörde gösterilen 
minimum renk sayısı) renkli bir palet sunan renk modeli 

Aratonlar: Siyah ve beyazın yaklaşık tam ortasında 
bulunan ton değerleri 

Aydınlık: Bir rengin veya tonun parlaklığının bir ölçüsü. 

Çıkarmalı Renkler (CMYK-cyan, magenta, yellow, 
kontrast-siyah):  Turkuaz, mor, sarı ve siyah baskı 
renklerinden oluşan renklerdir. Çıkartmalıdan kastedilen 
bu renkler belli % de oranları ile birleşince diğer renkleri 
oluştururlar. Bunlarla yapılan baskı işlemi dört renk 
işlemi olarak bilinir ve bir matbaa makinesinde renkli 
görüntüleri çoğaltmanın en çok kullanılan yoludur. 

Degrade: Bir renkten veya doymadan diğerine 
harmanlama, geçiş 

Doyma: Bir rengin şiddetinin ölçüsü. Örneğin pembe 
kırmızıdan , gökyüzü mavisi de lacivertten daha az 
doymuştur. 

Monokrom (Tek renk): Genellikle siyah beyaz bir 
monitörü belirtir, ama siyah beyaz bir görüntü içinde 
kullanılabilir. 

Nötrler: Belirgin bir renkleri olmayan gri tonları. 

Pantone: Belirli renkleri tutturmak için kullanılan ticari 
bir renk uyumlaştırma ve mürekkep karıştırma sistemi. 
MÜY yazılımları pantone sistemini desteklerler. 
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PMS: (Pantone Matching System): Tasarımcıların 
renkleri numaralarla ifade etmesini sağlayan sistem 

Renk serisi: Belirli bir aygıtla alınabilecek renk 
yelpazesi, monitörler, ışık üzerine kurulmuş olan RGB 
renk serisini gösterirler. Basılı malzemeler için ise 
mürekkep  renklerini kullanan CMYK renk serisi 
kullanılır. RGB renk serisi CMYK’dan daha geniştir. 

Renk Tekerliği: Değişik renkleri ve bu renklerin 
birbiriyle olan ilişkilerini gösteren pasta dilimi 
grafiklerine benzeyen şema. Çoğu zaman renk tekerleği 
on renge indirgenmiştir. Başta kırmızı olmak üzere 
turuncu, sarı, açık yeşil, koyu yeşil, turkuaz, mavi, koyu 
mor. 

Renk Uzayı: Renkli bir görüntünün tanımalıma ve 
depolama biçimi. Renk uzayına örnek olarak RGB, 
CMYK ve Kodak YCC gösterilebilir. 

RGB: (Red, green, blue) Renkli bir monitörde 
görüntünün gösterilmesi için kullanılan üç ana renk.  

Spot Rengi: (Özel renk) CMYK sisteminin dışında özel 
olarak kullanılan mürekkep rengi. Örneğin: pantone 
serisinden bir renk. 

Toplamsal renkler: (RGB-red, green, blue) Kırmızı, 
yeşil ve mavi ışığı anlatan bir kavram. Kırmızı, yeşil ve 
mavi ışık değişik yüzeylerde karşılaştırılınca, görünebilir 
renk yelpazesi oluşur. Bu renklerin her biri % 100 
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kullanılınca beyaz ışık meydana gelir. Monitörlerde 
kullanılan renklerdir.  
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ÜÇÜNCÜ BÖLÜM 

3. CORELDRAW 
3.1. Coreldraw Kullanmadan Önce Bilinmesi 

Gereken Terimler: 

CorelDRAW ile çalışmaya başlamadan önce aşağıdaki 
terimlere aşina olmalısınız. 

Object (Nesne): Resim, şekil, çizgi, metin, eğri, sembol 
veya katman gibi bir çizimdeki eleman 

Drawing (Çizim): CorelDRAW'da oluşturduğunuz 
çalışma; örneğin, özel sanat eserleri, logolar, posterler ve 
bültenler  

Vector Graphic (Vektör grafiği): Çizgilerin çizildiği 
konumu, uzunluğu ve yönü belirleyen matematiksel 
tanımlardan oluşan bir görüntü 

Bitmap: Piksel veya nokta ızgaralarından oluşan bir 
görüntü 

List Box (Liste kutusu): Bir kullanıcı aşağı ok 
düğmesini tıkladığında aşağı açılan seçeneklerin listesi 

Artistic text (Sanatsal metin):Gölgeler gibi özel 
efektler uygulayabileceğiniz bir metin türü 

Paragraph text (Paragraf metni): Biçimlendirme 
seçeneklerini uygulayabileceğiniz ve proje içeriğine 
büyük bloklarda düzenleyebileceğiniz bir metin türü.  
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3.2. Corel Draw’a Başlarken 

CorelDRAW, yüksek kaliteli vektör çizimler, logo 
tasarımları ve sayfa düzenleri oluşturmak için sezgisel ve 
çok yönlü bir grafik uygulamasıdır. 

Çok Sayıda efekt içermesi, esnek ara yüzü, işlemleri çok 
kısa sürede ön izlemeli olarak yapması ile öne çıkar. 
Metinler konusunda daha detaylı kontrol fonksiyonları 
içerir. Bitmap resimlere yönelik çok sayıda işlem 
yapmanızı sağlar. Ek olarak paketteki uygulamalar, hazır 
çizimler ve yazı tipleri ile gerçekten komple bir pakettir. 

3.3. Corel Draw Kısayolları 

Ctrl+C *Seçimi Kopyalar 
Ctrl+V *Seçimi Yapıştırır 
Ctrl+E *Export 
Ctrl+I *Import 
Ctrl+Z *Undo 
Ctrl+R *Repead 
Ctrl+P *Print 
Ctrl+O *Open 
Ctrl+N *New Documentn 
Ctrl+K *Seçili Nesneyi Ayırır 
Ctrl+L *Seçili Nesneyi Birleştirir. 
Ctrl+Q *Convert 
Ctrl+G *Grup 
Ctrl+U *Grup Dağıtır 
Shift+ PageUp *Nesne Metin Öne Alır 

http://bilgisayardershanesi.com/bilgisayar_dersleri/corel-draw-kisa-yollari.html
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Shift + PageDown *Nesne Metin Arkaya Alır 
CTRL+8 *Metni otomatik olarak büyütür 
CTRL+4 *Metni otomatik olarak küçültür 
CTRL+TAB *Sayfalar arası geçiş sağlar 
CTRL+A *Sayfadaki tüm nesneleri seçer 
CTRL+D *Metin yada nesneyi kopyalar 
+ *Nesne yada metni üstünde çoğaltır. 

HİZALAMA 

B *Seçili nesnelerin alt kısımlarını hizalar 

P *Seçili nesneleri sayfaya göre ortalar 
E *Seçili nesnelerin merkezlerini yatay olarak hizalar 
L *Seçili nesnelerin sol yanlarını hizalar 
R *Seçili nesnelerin sağ yanlarını hizalar 
T *Seçili nesnelerin üst kısımlarını hizalar 
C *Seçili nesnelerin merkezlerini düşey olarak hizalar 
Shift+B *Seçili nesneleri alt kenarlarına göre dağıtır. 
Shift+E *Seçili nesneleri yatay merkezlerine göre dağıtır. 
Shift+C *Seçili nesneleri düşey merkezlerine göre 
dağıtır. 
Shift+L *Seçili nesneleri sol kenara göre dağıtır. 
Shift+R *Seçili nesneleri sağ kenara göre dağıtır. 

• Daha çok kısayol tuşunu Tools > Customization > 
Commands > Shortcutkeys den görebilirisiniz. 

• Ayrıca bu menüden kısayol tuşlarını isteğinize göre 
ayarlayabilirsiniz. 
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3.4. Uygulama penceresi 

CorelDRAW'ı başlattığınızda, bir çizim penceresi içeren 
uygulama penceresi açılır. Birden fazla çizim penceresi 
açılabilmesine rağmen, komutları sadece aktif çizim 
penceresine uygulayabilirsiniz. 

CorelDRAW uygulama penceresi aşağıda görüntülenir. 

 

 

 

1. Araç Kutusu (Toolbox): Çizimdeki nesneleri 
oluşturmak, doldurmak ve değiştirmek için 
araçlara sahip bir sabit çubuk 
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Şekil 1. Toolbox 

2. Başlık çubuğu (Menu Bar):Şu anda açık çizimin 
başlığını gösteren alan 

 

3. Menü çubuğu : Aşağı açılan menü seçenekleri içeren 
alan 

 

4. Araç Çubuğu : Menüye ve diğer komutlara kısayollar 
içeren çıkarılabilir bir çubuk 

 

5. Çizim penceresi: Çizim sayfasının dışındaki alan, 
kaydırma çubukları ve uygulama kontrolleriyle sınırlanır. 
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6. Property Bar (Özellik çubuğu): Aktif araç veya 
nesneye ilişkin komutlar içeren çıkarılabilir bir çubuk. 
Örneğin, metin aracı aktif olduğunda, metin özelliği 
çubuğunda metin oluşturan ve düzenleyen komutlar 
görüntülenir (Window > Toolbars > Property Bar). 

 

7. Docker: Belirli bir araç veya göreve 
ilişkin mevcut komutları ve ayarları içeren 
bir pencere 

 

 

 

8. Cetveller (Rulers): Bir çizimdeki nesnelerin boyutunu 
ve konumunu belirlemek için kullanılan yatay ve dikey 
kenarlıklar. 

 

Şekil 2. Cetveller 
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9. Document Explorer (Belge Gezgini) :Uygulama 
penceresinin sol alt köşesinde, sayfalar arasında 
gezinmek ve sayfalar eklemek için kontroller içeren alan. 

 

10. Drawing Page  (Çizim sayfası): Çizim penceresinin 
içindeki dikdörtgen alan. Çalışma alanınızın yazdırılabilir 
alanıdır 

11. Status bar  (Durum çubuğu): Uygulama 
penceresinin altındaki tür, boyut, renk, dolgu ve 
çözünürlük gibi nesne özellikleri hakkında bilgi içeren 
bir alan. Durum çubuğu ayrıca mevcut imleç konumunu 
gösterir. 

 

12. Navigator: Bir çizimin etrafında hareket etmenize 
yardımcı olacak daha küçük bir ekran açan sağ alt 
köşedeki düğme 

13. Color Palettes  (Renk paleti): Renk örneklerini 
içeren sabitlenebilir bir çubuk. Window > Color Palettes 
> Default CMYK. Corel DRAW Programı ile çalışmalar 
uygulamalar ve örnekleri Resimli anlatım dersleri Corel 
draw Grafikerlerin kolayca kullanabileceği 
fonksiyonlarının çok fazla olan kullanım kolaylığı olan 
vektorel bir bir programdır. Birçok büyük Gazete Dergi 
gibi Matbaa Firmaları Corel ile çalışmaktadır Genelde 
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coreldraw ve photoshop birbirine çok benzerler aradaki 
fark sadece birisi Vektorel diğeri Pixel tabanlı 
olmasıdır.Mesela bir Logo oluştururken vektorel bir 
grafik yazılımı kullanmakta fayda vardır. Corel in 
marifetleri  saymakla bitmez Contour Convert Kareler 
Symboller ile çalışmalar yapılabilir. Nesneleri sabit 
renklerle renklendirirken kullanılabilecek en pratik 
araçlardır. 

Çok Sayıda efekt içermesi, esnek ara yüzü, işlemleri çok 
kısa sürede ön izlemeli olarak yapması ile öne 
çıkar.Metinler konusunda daha detaylı kontrol 
fonksiyonları içerir. Bitmap resimlere yönelik çok sayıda 
işlem yapmanızı sağlar.  

3.5. New Document  
3.5.1. YENİ BİR DOSYA AÇMAK 

‘New Graphic’ ikonunu tıkladığımızda yeni bir dosya 
açılır. 

Yeni açılan sayfada gereken bazı ön değerler (Sayfa 
boyu, sayfa yönü, uzunluk birimi gibi) daha önce 
kaydedildiği gibi olur. Sayfa boyutu ve değerleri 
değiştirirsek artık hep kaydettiğimiz ölçülerde ekrana 
gelecektir. sayfa ön değerleri ile ilgili yapılan 
değişiklikleri kaydetmek için 
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Tools/ Options/ Document ‘ Save options as default for 
new document’ seçeneğini işaretlemememiz 
gerekmektedir. 

3.5.2. Import Komutu ile Dosya Aktarımı 

Dosya yapısı CorelDRAW’dan çok farklı olan Bitmap 
ve metin dosyalarını CorelDRAW programına import  
komutu ile aktarabilirsiniz.  

Vektörel dosyaları Open komutu ile açarsak ayrı bir 
dosya olarak açılır. Import komutu ile açarsak açık olan 
dosya üzerine ekleyebiliriz. 

Örnek Çalışma 

Bir dosyaya çalışmanızı aktarmak için  

File/  Import u seçin. 

Look in bölümünde aktaracağınız dosyanın kayıtlı 
olduğu diski veya klasörü belirtin. 

Files of Type bölümünde aktaracağınız dosyanın tipi ya 
da All File formats seçili olsun. Açılan listeden 
aktaracağınız dosya üzerine tıklayın. Preview seçili ise 
aktarılan dosyanın küçük birörneği pencerede görünür. 
Import komutunu tıklayın. Bir sonraki adımda seçtiğiniz 
dosya tipine göre ayar yapacağınız pencere ekrana 
gelebilir. Gerekli ayarlar yapıldıktan sonra OK ikonunu 
tıklayın. İmleciniz köşe biçimini alacaktır. Aktaracağınız 
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dosyayı çalışma sayfasında nereye yerleştirirseniz orijinal 
boyutlarında dosya tıkladığımızda sağ altına yerleşir. 

Aktarılan dosyanın boyutunu değiştirmek istiyorsanız, 
aktarılacak dosyanın alanını farenin sol tuşunu kullanarak 
bir dikdörtgen çizerek belirtebiliriz. 

Aynı anda birden fazla dosya indirmek için Import 
penceresinde CTRL tuşuna basılı tutarken dosyaları 
işaretleyebiliriz. 

Scrapbook: Belirli bir klasördeki resim dosyalarını 
CorelDraw olmasa bile topluca görmemizi ve 
aktarmamızı sağlıyor.  

Ayrıca internet bağlantısı olan bilgisayarlarda burada 
arama yapabiliyor ve fotoğraf ve ses dosyalarını buradan 
arattırabiliyoruz. 

Browse: Herhangi bir dosyadaki veya CD’deki  bilgileri 
görebilmek için kullanılır.  

Search: İlgili CD sürücüye takılı ise aranılan kelime ile 
ilgili tüm dosyaları bulmaya ve aktarmaya yarıyor. 

Kaydetme 

File/ Save As ile dosya tipi görünümünde hangi formatta 
kaydedeceksek onu seçip dosyaları kaydedebiliriz. 

Dosya boş ise kayıt komutları aktif olmaz. 
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3.5.3. Export Komutu ile Dosya Aktarmak 

Dosyamızı raster ya da metin formatlarından birinde 
kaydetmek için 

File/ export seçin. Seçtiğimiz formata göre ayar penceresi 
açılır. 

Dosyayı Kapatma:  

File/ Close 

3.5.4. Hazır Şablon Kullanma (Template) 

Eğer bize sunulan hazır şablonlarla çalışmak 
istersek:Şablonlar.CDT uzantılı hazır çalışmalardır. Bu 
dosyalarda sayfa boyutu, sayfa düzeni gibi tüm ayarlar 
hazırlanmıştır. Bize sadece metin ya da grafiklerde 
değişiklik yapmak kalır. 

Bunları kullanmak için; 

File/ New from Template’i seçeriz. Ekrana 6 sekmeli bir 
pencere açılır.   

Full Page : Tek sayfalı şablonlar 

Label  : Etiket şablonları 

Booklet : Broşür kapağı tarzı şablonlar içerir. 

Side- fold :4<sayfalı tebrik kartı tarzı tasarımlar 
içerir. 
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Web  : Web sayfası şablonları içerir. 

Browse : Kayıtlı herhangi bir şablon dosyası 
kullanmamızı sağlar.  

Kullanılanlar 

Kılavuz çizgileri: Nesneleri sayfa üzerine yerleştirirken 
bu çizgilerden faydalanırız. 

Şekil 3. Template 

Ekranın solunda ve üstünde yer alan kılavuz 
çizgilerinden çekerek elde ederiz. Sayfa üzerinde kırmızı 
renkte görünür ve nesnelerin konumlarını ayarlamada 
bize yardımcı olur. 

Görünmüyorsa; View/ Guidelines menüsünü kontrol 
ederiz. Menünün yanında OK işareti yok ise kılavuz 
çizgileri görünmez. 

Kılavuz çizgilerin üzerine tıkladığımızda ekranın 
üzerinde yer alan çubukta  
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Object position (koordinat): x, y, 

Angle of rotation (dönme açısı), 

Center of Rotation Positiona (Ağırlık merkezi 
koordinatı) , 

Lock (Kilitleme), 

Snap to Guidelines (kılavuza yapış)Seçeneklerinden 
yararlanırız. 

Kılavuz çizgilerini kaldırmak için ise üzerlerine gelip 
‘Delete’ e basmak yeterlidir. 

Izgara: Çalışmalarımızı kolaylaştırmak amacıyla 
kullanırız.Izgaraları ekrana getirmek için View/ Grid 
seçeriz. Yok etmek için yine aynı yeri seçeriz.Izgaralar 
arasındaki boşlukları kendimiz ayarlayabiliriz. Bunun 
için View/ Grid and Ruler Setup’ı seçeriz. Bu komut 
aslında Tools/ Options/ Document/ Grids penceresini 
açar. 

Bu aralıkları ayarlamak için Spacing seçeneğini seçeriz. 

Horizantal (Yatay) 

Vertical (Dikey) kaç mm olacağını yazarak 
ayarlamamızı yaparız. 

Nesneye Yapış Komutu 
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Sayfa düzeni oluştururken nesnelerin birbirlerine 
yanaştıklarında yapışmaları için View/ Snap to Object 
seçin. İşlemden vazgeçmek için yine aynı komutu 
seçeriz. 

İşlemi Tekrarlama 

Son yaptığımız işlemi tekrarlamak için işlemin 
uygulanacağı nesneyi seçerek Edit/ Repeat komutunu 
uygularız. Her işlemi tekrarlayamazsınız. 

Nesneyi Kopyalama 

Seçili nesnenin bir kopyasını oluşturmak için 
kopyalamak istediğimiz nesneyi seçerek Edit/ Dublicate 
komutunu seçeriz. 

Kopyanın diğer nesneye göre konumunu belirlemek için 
önceden X, y koordinatlarını düzenleyerek 
oluşturduğumuz kopyanın değere bağlı olarak yerlerine 
yerleştirileceğini görürüz. Böylece konum ve yer 
değişimi otomatik olarak uygulanacaktır. 

Nesnelerin Özelliklerini Kopyalama 

Bir nesnenin dolgu, metin ve diğer özelliklerini bir başka 
nesneye kopyalayabilmek için Edit/ Copy Properties 
from komutunu seçin. Ekrana gelen pencerede nesnenin 
hangi özelliklerini değiştirmek istediğimizi bildirmemiz 
gerekir.  
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Tam ekran ön izleme için  

View/ Full-Screen Preview seçeriz. 

Büyüteç Aracı 

Çok Sayfalı Çalışma 

Bunun için Layout menüsünden Insert Page seçin. Gelen 
pencerede Insert.. pages satırında eklemek istediğimiz 
sayfa sayısını yazarız. Before çalışılan sayfanın önüne 
After ise arkasına yeni sayfaları ekleyecektir. 

Sayfa silmek istersek yine aynı menüden Delete 
komutunu seçmemiz yeterli olacaktır. 

İstersek sayfa etiketlerinden sayfalara isim verebiliriz. 

Corel Draw 10 da bir diğer yeni yenilik ise View/ Page 
Sorter View seçtiğinizde tüm sayfaları bir arada gösteren  

Çok Sayfalı Dökümanların Çıkış Sırasının 
Belirlenmesi 

Yazıcı çıkışında sayfa sırasının otomatik olarak 
belirlenmesi için 

Layout/ Page Setup seçeneğini seçerek Option 
penceresini  açalım. Pencerenin solunda yer alan listede 
Document/ Page/Layout satırında tıklayalım. 
Pencerenin sağ yarısında artık sayfa sıralaması ile ilgili 
seçenekler yer almaktadır. Layout bölümünden bize 
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uygun olanı seçeriz. Nasıl olacağını görmek için sağ üst 
köşedeki görüntülere bakmak yeterlidir. 

Etiket Çıkışı Almak İçin 

Yine aynı yerden bu kez Layout/ Page Setup 
seçeneğinden Option seçeneğini açarız burada Label 
seçeneğini seçerek tercih edebileceğimiz etiket 
seçeneklerini görürüz.  

Etiketleri biz tasarlamak istersek; 

Labels penceresinde Customize Labels ikonunu tıklarız. 

Lyout/ Rows bölümüne sayfadaki etiketlerin kaç satır 
oluşturduğunu Layout/ Cloumns bölümüne de kaç sütun 
oluşturduğunu yazarız. 

Label Size/ Width genişliğini 

Label Size/ Height ise etiketin yüksekliğini yazarız. 

Rounded Corners seçili ise etiketlerin köşelerinin 
yuvarlak olduğunu varsayar. 

Gutter/ Horizontal sütunlar arası boşluğu 

Gutters/ Vertical satırlar arasındaki boşluğu yazarız. 

Tasarladığımız etiketi kaydetmek için Sol üst köşedeki 
label style bölümünde yer alan + ikonunu tıklarız. Etikete 
vermek istediğimiz ismi yazarız. Artık bu etiket 
listesinde User Defined de yer alır. 
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DÖRDÜNCÜ BÖLÜM 

4. TOOLBOX 

SHAPE TOOL (F10) 

Shape Tool:Düğüm noktaları sayesinde objelerinizin, 
metinlerinizin üzerinde müdahale ederek biçimini 
değiştirebilirsiniz. 

Knife Tool:Bu aracı kullanırken herhangi bir düğüm 
noktasına ihtiyacınız yok. Kesme işlemini yapacağınız 
noktanın üzerine geldiğinizde Knife aracı dik bir konuma 
gelecektir. Daha sonra istediğiniz biçimde kesme işlemini 
yapabilirsiniz. Son noktaya gelindiğinde fareyi bırakın ve 
seçim aracını alarak kestiğiniz parçayı tutun ve çekin. 

Eraser Tool:Eraser aracını seçtiğinizde Property Bar 
üzerinde Eraser aracına ait iki değişik özellik çıkar. 
Yapacağınız ilk ayar silginin kalınlığı ile ilgili, diğeri de 
silginizin yuvarlak kare olarak seçmenizi sağlar. 

Smudge Brush:Corel’in tasarımcılara çalışmalarında 
yeni ilhamlar veren araçlarından bir tanesi. Photoshop’un 
Brush özelliklerinde “Fade” özelliğinin Corel’deki 
vektörel yansıması denilebilir. Smudge aracını seçtikten 
sonra değişen Property Bar üzerinde örnek resimdeki 
seçeneklere değerler girin. Bir Rectangular dikdörtgen 
nesne oluşturun ve istediğiniz biçimde renklendirin. 
Smudge ile içeriden dışarıya, dışarıdan içeriye müdahale 
ederek farklı etkilerde bulunabilirsiniz. 
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Roughen Brush: Oluşturduğumuz çizimlerimizin 
etrafında girintili çıkıntılı tırtıklar oluşturmak için 
kullanabileceğimiz özel ayarlarla farklı görünümler 
oluşturabileceğimiz bir araç. 

Free Transform: Toolbox’tan aracı tıklar tıklamaz 
Property Bar üzerinde değişen bölüm içinde Free 
Transform ile nesnenin (Rotate) açısını, (Reflection) 
yansımasını, (Scale) büyüklüğünü, (Skew) bir düzlem 
üzerinde eğimini düzenleyebilirsiniz. Property Bar 
üzerinde nümerik değerlerle özel kontroller bulunuyor. 

Virtual segment Delete: Birbiri üzerine binen başka 
nesnelerin yolları ile kesişen hedef alınmış bir nesne yolu 
parçanızı silmenize imkan veren, etkileşimli bir kırpma 
aracıdır. 

ZOOM TOOLZ): 

Zoom: Sayfanızı büyültür ve küçültür. 

Pan: Sayfanızı çizim alanı ile birlikte kaydırır. 

FREEHAND TOOL (F5): 

Freehand tool:Bu araç, aynen pencil aracı gibi çalışır. 
Sürüklendiğinde fare imlecini bir çizgi takip eder. Çizim 
yapıldıkça, CorelDRAW, çizginin belirli aralıklarına 
düğüm noktaları yerleştirmeye başlar. Daha az düğüm 
noktası daha düzgün bir çizim demektir. Fazla düğüm 
noktasına sahip çizgiler biraz bozuktur. Çünkü her 
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düğüm noktası bir çekim alanı oluşturur. Çizginin, fare 
hareketlerini ne kadar yakından takip edeceği, property 
çubuğundaki Freehand Smoothing sürgüsünden 
belirlenir. 

Dümdüz çizgiler ise bambaşka bir yoldan elde edilir. 
Sürüklemek yerine, çizginin başlangıç yerine bir kez 
tıklanır. Sonra fare ile çizginin sonlanacağı yere de 
tıklanır. Bu iki nokta arasında dümdüz bir çizgi meydana 
gelecektir. Yatay ve dikey çizgiler oluşturmak için CTRL 
tuşuna basılı tutmak yeterli olur. 

Bézier Aracı: Bézier aracı üzerinde uzmanlaşmak için 
üzerinde pratik yapmak gerekir. Bu araç bir eğrinin 
çiziminde ona dilediğimiz şeklin verilmesini sağlıyor. 
Fare ile tıklandığında yeni bir düğüm noktası oluşturuyor 
ve bu düğüm noktası ile bir öncekini birleştiriyor. 
Üzerine gelip tıkladıktan sonra, imleci sürükleyerek, 
eğriye değişik biçimler verilmesini sağlıyor. 

Bézier ve Kalem araçları, her bir düğümü hassas bir 
şekilde yerleştirerek ve her eğimli parçanın şeklini 
kontrol ederek bir kerede bir segment çizmenizi sağlar. 
Kalem aracı, çizerken çizgi bölümlerini ön izleme 
olanağı sunar. 

Artistic Media Aracı: Curve açılır penceresinden 
Artistic Media Aracı seçildiğinde Property çubuğu 
aşağıda gibi değişecektir. 
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B-Spline Aracı: bu araç farklı sektörlere özel üretilmiş 
uzman yazılımlarda bulunan bir araç. Çizim yapmayı 
oldukça kolaylaştıran ve hızlandıran bir seçenek. 
Bununla saniyeler içinde dekupe yapabilirsiniz.  

2 Point line tool: 2 Nokta Çizgi aracını kullanarak düz 
çizgiler çizebilirsiniz. Bu araç aynı zamanda nesnelere 
dik veya teğet olan düz çizgiler oluşturmanızı sağlar. 

3 Nokta Eğri aracı:  3 Nokta Eğri aracı, genişliklerini ve 
yüksekliklerini belirterek basit kavisli çizgiler çizmenize 
olanak tanır. Düğümleri manipüle etmeden hızlı bir 
şekilde yay şekilleri oluşturmak için bu aracı 
kullanabilirsiniz. 

Smart Fill (Akıllı Çizim aracı) : Tanıma ve temel 
şekillere dönüştürülebilen serbest vuruş vuruşlarını 
çizmek için Akıllı Çizim aracını kullanabilirsiniz. Bir 
nesne bir şekle dönüştürülmezse düzleştirilir. 
CorelDRAW'un şekilleri tanır ve nesneler haline 
dönüştürdüğü seviyeyi ayarlayabilirsiniz. düğümleri 
değiştirmeden şekilleri hızla yayar. 

Rectangle:İstenilen boyutlarda dikdörtgen çizmenizi 
sağlar. 

Elipse:İstenilen boyutlarda elipsler çizmenizi sağlar. 

Graph Paper tool D): İstenilen satır ve sütunda grafik 
kağıtları çizer. Yazı yazmanıza yardımcı olur. 
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Polygon tool:Çeşitli sayıda köşelere sahip poligonlar ve 
yıldızlar çizmenize yardımcı olur. 

Spiral:İstenilen sayıda spiral içmenize yardımcı olur. 

Interactive Blend Tool:objeyi birbirine geçiş yaparak 
birleştirir. 

Interactive Contour:Objelere istenilen özelliklerde 
kontür atmanızı sağlar. 

Interactive drap shadow:Objelere gölge efekti uygular. 

Interactive Envelope :Objeleri eğritmek için kullanılır. 

Interactive Extrude:Objelere 3D efekti verir. 

Transparency İnteractive:Etkileşimli olarak objelere 
şeffaflık verir. 

Eyedropper:Objeler içerisindeki rengi kopyalar. 

Paintbucket tool:Örnek aldığınız rengi objenize uygular. 

INTERACTIVE FILL: Nesneleri doldurmanın en iyi 
yöntemi bu aracı kullanmaktır. İnteractive fill aracı seçili 
iken Property Bar üzerinde ki açılır mönünün yanında 
bulunan aşağı ok işaretine basın. Burada dört dolgu tipi 
bulunur. Bunlar Fountain, Pattern, Texture ve Postscript. 
Biz fountain dolgu ile başlıyoruz. 

INTERACTIVE MESH ARACI: Bu araç sayesinde 
nesnelerin interaktif olarak, eklendikçe birbirleri ile 
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harmanlanan renkler ile doldurabiliyorsunuz. Ayrıca bu 
araç seçili konumda iken Propert Bar üzerındeki 
seçenekler görülebiliyor. 

4.2. Corel Draw Menü Açıklamaları 

4.2.1. File (Dosya) Menüsü 

New (Ctrl+N): Yeni bir Corel dosyası açmak için 
kullanılır. 

New From Template: Corel’in hazır şablonlarından 
faydalanarak yeni bir çalışma sayfası açar. 

Open (Ctrl+O): Daha önceden hazırlanmış bir Corel 
dosyasını açar. 

Close (Ctrl+F4): O an açık olan corel çalışma sayfasını 
kapatır. 

Save (Ctrl+S): Corel çalışmasını kaydetmeye yarar. 

Save As (Ctrl+Shift+S): Corel çalışmasını farklı bir 
isimde veya farklı bir yere kaydeder. 

Revert: Corel çalışmasını dosya açıkken en son 
kaydedilmiş haline çevirir. 

Acquire Image: Corel sayfasına harici bir kaynaktan 
(tarayıcı, dijital fotoğraf makinesi) fotoğraf veya imaj 
yükler 

Select Source: İmajların alınacağı kaynağı seçer. 
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Acquire: İmaj yükleme işlemini başlatır. 

Import (Ctrl+I): Corel programının direkt açamadığı 
formatları (tif, jpg, psd...) açmak için kullanılır.  

Export (Ctrl+E): Corel dosyasını başka bir formatta (tif, 
jpg, psd, bmp, ai, eps..) kullanmak için kullanılır. 

Send To: Corel çalışmasını bilgisayardaki herhangi bir 
hedef klasöre veya başka bir program çalışmak üzere 
yönlendirme / kayıt yapar. 

Print (Ctrl+P): Corel çalışmasını yazıcıya gönderir. 

Print Preview: Baskıdan önceki son halini gösterir. 

Print Setup: Yazıcı ayarlarının yapılmasını sağlar. 

Prepare For Service Bureau: Corel çalışmasını içindeki 
fontlarla beraber, istenirse pdf formatında da hedef bir 
klasöre kaydetmeyi sağlar. 

Publish The Web: Corel çalışmasını internet ortamında 
kullanılmak üzere html, swf (Macromedia flash dosyası), 
jpg, gif, png formatlarında kaydetmeyi sağlar. 

Publish The PDF: Corel çalışmasını Adobe Acrobat 
programına uygun formata çevirir (pdf). 

Document Info: Üzerinde çalışılan Corel dosyası 
hakkında ayrıntılı bilgileri görmeyi sağlar. 
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Recent Files: En son çalışılan corel dosyalarının listesini 
verir. 

Exit (Alt+F4) : Corel programını kapatır. 

 

Şekil 4. Coreldraw Arayüz görünümü 

4.2.2. Edit (Düzenle) Menüsü  

Undo (Ctrl+Z): Yapılan işlemleri geriye doğru alır. 

Redo (Ctrl+Shift+Z): Yapılan işlemleri ileriye doğru 
alır. 

Repeat (Ctrl+R): En son yapılan işlemi tekrarlar. 

Cut (Ctrl+X): Kes 
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Copy (Ctrl+C): Kopyala 

Paste (Ctrl+V): Yapıştır 

Paste Special: Daha önceden başka bir programda 
kopyalanmış bir nesneyi özel bir biçimde yapıştırır. 

Delete (Delete) : Sil SymbolSeçilen bir nesneyi sembole 
çevirir. 

New Symbol: Seçilen nesneyi sembole çevirir. 

Edit Symbol: Sembole çevrilen nesnenin 
düzenlenmesini sağlar. 

Finish Editing Symbol: Sembole çevrilen nesnenin 
düzenlenmesi işini sonlandırır. 

Revert To Objects: Sembole çevrilen nesnenin objeye 
çevrilmesi sağlar. 

Library: Sembole çevrilen nesnelerin saklandığı 
kütüphaneyi açar. 

Duplicate (Ctrl+D): Seçilen nesne(ler)yi çoğaltır. 

Clone: Seçilen nesne(ler)yi tekrar üretip çoğaltır. 

Copy Properties From: Seçilen bir nesneye başka bir 
nesnenin özelliklerinin kopyalanmasını sağlar. 

Select All: Corel çalışmasındaki her şeyi seçmeyi sağlar. 

Objects: Corel çalışmasındaki nesneleri seçer (her şeyi) 
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Text: Corel çalışmasındaki yazıları seçer. 

Guidelines: Corel çalışmasındaki rehber çizgileri seçer. 

Nodes: Corel çalışmasındaki eğriye çevrilmiş 
(convertlenmiş) çizimlerde bulunan eğri noktalarını 
seçer.  

Find And Replace: Corel çalışmasındaki nesneleri 
istenen özelliklere göre bulup değiştirmeyi sağlar. 

Find Objects: Seçilen özelliklere göre nesnelerin sayfa 
içinde bulunmasını sağlar.  

Replace Objects: Seçilen özelliklere göre nesnelerin 
değiştirilmesini sağlar.  

Find Text: Seçilen özelliklere göre yazıların 
bulunmasını sağlar. 

Replace Text: Seçilen özelliklere göre yazıların 
değiştirilmesini sağlar. 

Recent Search: En son yapılan Find and Replace 
özelliğini tekrarlar. 

Insert Internet Object: Corel çalışmasına internet 
ortamında kullanılmak üzere buton, java apletleri, yazı 
alanları, seçim listeleri, açılır pencereler (popup) ekler. 

Insert Barcode: Corel çalışmasına barkod numaraları 
ekler (bunun için corel barcode programının kurulması 
gerekmektedir). 
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Insert New Object: Corel sayfasına yeni bir nesne 
eklenmesini sağlar. Çıkan seçim listesinden yapılacak 
seçime göre uygun program açılır ve düzenleme 
yapılması istenir. 

Links: Corel çalışmasında seçilen nesnenin harici bir 
kaynağa bağlantı kurmasını sağlar. 

Properties: Corel çalışmasında seçili olan nesne(ler)in 
özellikleri hakkında bilgi verir. 

4.2.3. View (Görünüm) Menüsü 

Simple Wireframe: Corel Sayfasındaki tüm şekillerin 
çizgisel olarak görünmesini sağlar. 

Wireframe: Corel sayfasındaki tüm şekillerin efektler 
hariç çizgisel olarak görünmesini sağlar. 

Draft: Corel sayfasındaki çalışmanın görüntü kalitesinin 
en düşük seviyede tutulmasını sağlar. 

Normal: Corel sayfasındaki çalışmanın görüntü 
kalitesinin normal seviyede tutulmasını sağlar. 

Enhanced: Corel sayfasındaki çalışmanın görüntü 
kalitesinin en iyi seviyede tutulmasını sağlar. 

Full Screen Preview: Corel çalışmasının tam ekran 
görüntüsünü verir. 

Preview Selected Only: Corel çalışmasında sadece seçili 
olan nesnenin tam ekran görüntüsünün verilmesini sağlar. 
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Page Sorter View: Corel sayfasının sıralı bir liste 
halinde ekranda görünmesini sağlar. 

Rulers: Corel sayfasında cetvellerin görünmesini sağlar. 

Grid: Corel sayfasında ızgaraların görünmesini sağlar. 

Guidelines: Corel sayfasında rehber çizgilerin 
görünmesini sağlar. 

Show: Corel sayfasında seçime göre bazı özelliklerin 
görünmesini sağlar. 

Page Border: Corel çalışmasında zeminde sanal bir 
sayfa alanının görünmesini sağlar. 

Bleed: Corel çalışmasında sanal sayfa alanının etrafının 
kesik çizgilerle görünmesini sağlar. 

Printable Area: Corel sayfasında yazdırılabilir alanın 
görünmesini sağlar. 

Overprinted Objects: Corel sayfasında yazdırma 
alanının dışında kalan nesnelerin görünmesini sağlar. 

Text Frame: Corel sayfasında yazı alanlarının etrafında 
frame çizgilerinin görünmesini sağlar. 

Enable Rollover: Corel sayfasında internet ortamında 
kullanılmak üzere oluşturulacak butonların üzerine 
gelindiğinde, butona basıldığında ve butona basıldıktan 
sonraki görünümü ayarlamak için kullanılır. 
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Snap To Grid(Ctrl+Y): Corel sayfasında nesnelerin 
ızgaraları mıknatıs etkisiyle yakalamasını sağlar. 

Snap To Guidelines: Corel sayfasında nesnelerin rehber 
çizgileri mıknatıs etkisiyle yakalamasını sağlar. 

Snap To Objects: Corel sayfasında nesnelerin diğer 
nesneleri mıknatıs etkisiyle yakalamasını sağlar. 

Grid And Ruler Setup: Izgara ve cetvellerle ilgili 
ayarların yapılacağı menüye gider. 

Guidelines Setup: Rehber çizgilerle ilgili ayarların 
yapılacağı menüye gider. 

Snap To Objects Setup: Nesnelerin nesneleri mıknatıs 
etkisiyle yakalaması ile ilgili ayarların yapılacağı menüye 
gider. 

4.2.4. Layout (Sayfa Düzeni) Menüsü  

Insert Page: Açık olan corel dosyasına yeni bir sayfa 
eklemeyi sağlar. 

Delete Page: Açık olan corel dosyasından varolan 
sayfalardan birinin silinmesini sağlar. 

Rename Page: Açık olan corel dosyasındaki sayfalara 
isim verilmesini / değiştirilmesini sağlar. 

Go To Page: Açık olan corel dosyasında sayfalar 
içerisinde istenilen bir sayfaya ulaşmayı sağlar. 
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Switch Page Orientation: Corel sayfasının yatay veya 
dikey olarak yerleşimini belirlemeyi sağlar. 

Page Setup: Corel çalışma sayfasının ölçü gibi bazı 
özelliklerinin ayarlandığı menüye gider. 

Page Background: Corel çalışma sayfasının zemin rengi 
ile ilgili ayarlamaların yapıldığı menüye gider. 

4.2.5. Arrange (Hizalama) Menüsü  

Transformation: Corel sayfasında seçili nesnelerin 
konum, eğim, eğrileme, çevirme, ölçülendirme gibi 
ayarlamalarını yapar. Position: Seçili nesnenin x ve y 
koordinatlarında konumunun değiştirilmesini sağlar. 

Rotation: Seçili nesnenin bir açı değeri girilerek 
çevrilmesini sağlar. 

Scale And Miror: Seçili nesnenin yüzde cinsinden 
ölçeklendirilmesi ve yansımasının oluşturulmasını sağlar 
Size Seçili nesnenin yeniden ölçeklendirilmesini sağlar.  

Skew: Seçili nesnenin verilen açı değerinde yatay veya 
dikey düzlemde eğriltilmesini sağlar. 

(Not: Transformation menüsü seçildiğinde corel 
sayfasında sağda açılacak olan menü grubunun altında 
yer alan “Apply” sadece istenilen özelliğin 
uygulanmasını, “Apply to Duplicate” ise istenilen 
özelliklerin, seçilen nesnenin kopyasını oluşturarak, 
kopyasına uygulanmasını sağlar.) 
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Clear Transformation: Transformation menüsüyle 
yapılan bütün değişikliklerin temizlenmesini, iptal 
edilmesini sağlar. 

Align and Distribute: Corel sayfasında seçili olan iki 
yada daha fazla nesnenin birbirine göre konumlarının 
ayarlanmasını sağlar. 

(Not: Hizalama işlemi yapılmadan önce uygulama 
yapılacak nesnelerin seçimi çok önemlidir. İlk seçilecek 
nesne referans alınacak nesne olup, “shift” tuşuna 
basılarak seçilecek ikinci nesne ise hizalama işlemlerinin 
uygulanacağı nesne olacaktır. 

Align Left (L): İkinci nesnenin ilk nesnenin sol tarafına 
hizalanmasını sağlar. 

Align Right (R): İkinci nesnenin ilk nesnenin sağ 
tarafına hizalanmasını sağlar. 

Align Top (T): İkinci nesnenin ilk nesnenin üst tarafına 
hizalanmasını sağlar. 

Align Bottom (B): İkinci nesnenin ilk nesnenin alt 
tarafına hizalanmasını sağlar. 

Align Centers Horizontally (E): İkinci nesnenin ilk 
nesnenin yatay olarak ortasına hizalanmasını sağlar. 

Align Centers Vertically (C): İkinci nesnenin ilk 
nesnenin dikey olarak ortasına hizalanmasını sağlar. 
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Center to Page (P): Seçili olan nesne(ler)in çalışma 
sayfasının hem yatay hem de dikey olarak ortasına 
hizalanmasını sağlar. Center to Page Horizontally: 
Seçili nesne(ler)in yatay olarak çalışma sayfasının 
ortasına hizalanmasını sağlar. 

Center to Page Vertically: Seçili nesne(ler)in dikey 
olarak çalışma sayfasının ortasına hizalanmasını sağlar. 

Order: Seçili nesnelerin birbirlerine göre hangi 
katmanda yer alacağının belirlenmesini sağlar. 

To Front: Seçili nesne(ler)in diğer tüm nesnelere göre en 
üst katmanda yer almasını sağlar. 

To Back: Seçili nesne(ler)in diğer tüm nesnelere göre en 
alt katmanda yer almasını sağlar. 

Forward One: Seçili nesne(ler)in diğer tüm nesnelere 
göre bir katman yukarıda yer almasını sağlar. 

Back One: Seçili nesne(ler)in diğer tüm nesnelere göre 
bir katman aşağıda yer almasını sağlar. 

In Front Of: Seçili olan nesnenin seçilecek olan ikinci 
nesnenin bir katman önüne geçmesini sağlar. 

Behind: Seçili olan nesnenin seçilecek olan ikinci 
nesnenin bir katman arkasına geçmesini sağlar. 

Group (Ctrl+G): Seçili olan nesnelerin gruplanmasını 
sağlar  



49 

 

Ungroup (Ctrl+U): Gruplu olan nesnelerin gruplarının 
çözülmesini sağlar. 

Ungroup All: Corel sayfasında gruplanmış olan tüm 
nesnelerin grupların çözülmesini sağlar. 

Combine (Ctrl+L): Seçilen nesnelerin alanlarının daha 
sonra ayrılabilecek şekilde kombine olmasını sağlar. 

Break Apart (Ctrl+K): Kombine, özel efektler, kontur 
vb. bazı eklentiler kullanılarak oluşturulan nesneleri 
birbirinden ayırmak, efektleri kırmak için kullanılır. 

Lock Object: Seçili nesneleri üzerinde hiçbir işlem 
yapılamayan bir konuma çevirir, kilitler. 

Unlock Object: Kilitlenmiş nesneleri çözer. 

Unlock All Object: Corel çalışmasında varolan tüm 
kilitli nesneleri çözer. 

Shaping: Corel çalışmasında iki yada daha fazla şeklin 
alanlarını birbirlerine göre düzenler. 

Weld: Seçilen nesnelerin alanlarını birleştirir, tek bir 
alan haline getirir. 

Trim: İlk seçilen nesnenin alanını ikinci seçilen nesnenin 
alanından çıkarır. 

Intersect:Seçilen iki nesnenin alanlarının kesiştiği kısmı 
yeni bir alan olarak verir. 
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Simplify: Seçilen iki nesneden en üst katmanda bulunan 
nesnenin alanını bir alt katmanda yer alan nesneden 
çıkarır. 

Front Minus Back: Seçilen iki nesneden alt katmanda 
yer alan nesnenin üst katmanda yer alan nesnenin 
alanıyla kesiştiği alanı ve alt katmanda yer alan nesnenin 
alanının tamamını siler. 

Back Minus Front: Seçilen iki nesneden üst katmanda 
yer alan nesnenin alt katmanda yer alan nesnenin alanıyla 
kesiştiği alanı ve üst katmanda yer alan nesnenin alanının 
tamamını siler. 

Convert to Curves (Ctrl+Q): Seçili yazı ve şekilleri 
serbest eğrilere çevirir. 

Convert Outline To object (Ctrl+Shift+Q): Seçili yazı 
ve şekillerin kenar çizgilerini serbest eğrili alanlara 
çevirir. 

Close Path: Freehand, bezier, pen, polyline, 3 point 
curve, interactive connector, dimension çizim araçlarıyla 
yapılan çizimlerde eğer noktalar birleştirilmemişse, bu 
noktaların birleşmesini sağlar. 

Closes Nodes With Straight Lines: Yukarıdaki çizim 
araçlarıyla yapılan çizimlerde birleştirilmemiş noktaların 
arasını düz çizgi olarak birleştirir. 
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Closes Nodes With Curvy Lines: Yukarıdaki çizim 
araçlarıyla yapılan çizimlerde birleştirilmemiş noktaların 
arasını serbest eğrili çizgiler olarak birleştirir. 

Start to End With Straight Lines: Yukarıdaki çizim 
araçlarıyla yapılan çizimlerde çizimin başlangıç ve bitiş 
noktalarının arasını düz bir çizgi ile birleştirir. 

4.2.6. Effects (Efektler) Menüsü  

Adjust: Corel sayfası içerisine çağırılan (import edilen) 
resim dosyalarının ışık, kontrast ve renk ayarlamalarının 
yapılmasını sağlar. 

Contrast Enhancement: Seçili resmin renk kanalları 
üzerinden (hem tüm renk kanallarına hem de renk 
kanallarına ayrı ayrı uygulanabilir) kontrast 
düzenlemelerinin yapılmasını sağlar. 

Local Equalization: Seçili resim üzerinde eni ve(ya) 
boyu üzerinden bölgesel ışık ayarlamalarının yapılmasını 
sağlar. 

Sample / Target Balance: Seçili resim üzerinde 
eyedroper aracıyla referans seçilen renkten hareket 
edilerek resmin yeniden renklendirilmesini sağlar. 

Tone Curve: Seçili resim üzerinde corel programının 
oluşturduğu diyagram üzerindeki curve çizgilerinin 
hareketiyle yeniden renklendirme işlemi yapar.  
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Auto Equalize: Seçili resim üzerinde corel programının 
otomatik olarak uyguladığı bir renklendirme işlemi 
yapar. 

Brightnes/Contrast/ Intensity (Ctrl+B): Seçili resim 
üzerinde ışığın açıklık-koyuluk ayarlarının yapılmasını 
sağlar. 

Color Balance (Ctrl+Shift+B): Seçili resim üzerinde 
renk kanalarına doğru kaydırma yöntemiyle yeniden 
renklendirme işlemi yapar. 

Gamma: Seçili resim üzerinde gama değerlerinde 
değişiklik yapılarak resmin yeniden parlaklık 
düzenlemesini sağlar. 

Hue / Stration / Lightnes (Ctrl+Shift+U): Seçili resim 
üzerinde RGB ve CMYK renk kanallarının ayrı ayrı 
seçilmesiyle resme yeniden renk ve parlaklık verilmesini 
sağlar. 

Selective Color: Seçili resim üzerinde CMYK renk 
kanallarında ki kaydırma seçenekleriyle resmin yeniden 
renklendirilmesini sağlar. 

Desaturate: Seçili resmin orijinal renk kanallarını 
muhafaza ederek resmin grayscale (gri tonlu) bir 
görünüm kazanmasını sağlar. 
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Cahannel Mixer: Seçili resim üzerinde “Color Balance” 
özelliğinde olduğu gibi renk kanallarında kaydırma 
yaparak resmin yeniden renklendirilmesini sağlar. 

Transform: Seçili resim üzerinde görüntü kalitesi ve 
görünüm ile ilgili bazı düzenlemeler yapar. 

DeInterlace: Seçili resimde isteğe bağlı bir analiz 
yaparak pikselleri interpolasyon veya çoğaltma 
yöntemiyle yeniler. 

Invert: Seçili resmin renklerini tersine çevirerek yeni bir 
görünüm kazandırır.  

Posterize: Seçili resim üzerinde uygulanan efektlerden 
biridir. 

Correction Dust and Scratch: Seçili resim üzerinde 
treshold ve radius değerlerinde değişiklik yaparak resmin 
bulanık veya keskin netlikte olmasını sağlar. 

Artistic Media: Fırça çizim aracıyla yeni desenler 
oluşturulmasını sağlar.  

Blend: Seçili iki çizilmiş şekil arasında var olan boşluğu 
yeni şekiller üreterek tamamlamayı sağlar. 

Contour: Seçili çizimin etrafında istenilen özellikte bir 
alan oluşturulmasını sağlar. 

Envelope: Seçili çizim üzerinde kenarların eğimli hatlara 
sahip olmasını sağlar. 
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Extrude: Seçili çizim üzerinde 3 boyutlu görünüm elde 
edilmesini sağlar. 

Lens: Seçili şekil(ler) üzerinde bazı efektlerin 
uygulanmasını sağlar. 

Add Perspective: Seçili çizime perspektif, derinlik hissi 
verilmesini sağlar. 

Power Clip: Bir nesneden çizilmiş bir şeklin alanı kadar 
bir bölümü kesmeyi sağlar. 

Rollover: İnternet ortamında kullanılmak üzere buton 
yapılmasını sağlar. 

Clear Effect: Seçili nesne üzerinde uygulanan efektlerin 
temizlenmesini sağlar. 

Copy Effect: Seçili olan bir nesneye başka bir nesne 
üzerinde uygulanmış olan efektlerin kopyalanmasını 
sağlar. 

Clone Effect: Seçili bir nesnede daha önce üzerinde 
efekt uygulanmış nesnenin efektlerinin çoğaltılmasını 
sağlar.  

4.2.7. Bitmaps (Resimler) Menüsü  

Convert to Bitmap: Seçili nesnenin resme çevrilmesini 
sağlar. 

Edit Bitmap: Seçili resmin Corel Photo Paint 
programında düzenlenmesini sağlar. 
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Crop Bitmap: Seçili resmin kesilmesini sağlar (Burada 
Crop Bitmap butonu aktif değildir, kesme işlemi “Shape 
Tool” (F10) aracıyla yapılır). 

Trace Bitmap: Seçili resmin Corel Trace programında 
vektörel çizime dönüştürülmesini sağlar. 

Resample: Seçili resmin yatay ve(ya) yatay düzlemde 
yeniden ölçülendirilmesini ve çözünürlüğünün yeniden 
ayarlanmasını sağlar. 

Mode: Seçili resmin hangi renk kanalında olduğunu 
gösterir ve sahip olduğu renk kanalının değiştirilmesini 
sağlar. 

Inflate Bitmap: Seçili resmin sayfa içerisinde resim 
olarak kapladığı ölçünün değiştirilmesini sağlar. 

BitmapColor Mask: Seçili resim üzerinde atanacak bir 
renk üzerinden bir maske uygulamasının yapılmasını 
sağlar. 

Resolve Link: Seçili resme harici bir kaynağa link, 
bağlantı verilmesi ile ilgili düzenlemeler yapar. 

Update From Link: Seçili resme verilen bağlantının 
güncelleştirilmesini sağlar. 

3D Effects: Seçil resme üç boyutlu efektler verilmesini 
sağlar. 
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Art Strokes: Seçili resmin zeminine dolgu efektlerinin 
uygulanmasını sağlar. 

Blur: Seçili resim üzerinde resmin görüntüsünde bulanık 
etkisinin oluşturulmasını sağlar. 

Camera: Seçili resim üzerinde kameralarda bulunan 
noise etkisinin oluşmasını sağlar. 

Color Transform: Seçili resim üzerinde sahip olduğu 
renk kanallarıyla oynayarak nokta bazında yeni görünüm 
almasını sağlar. 

Contour: Seçili resmin piksellerini baz alarak piksellerin 
etrafında değişiklik yapıp resmin yeni bir görünüm 
almasını sağlar. 

Creative / Distort / Sharpen: Seçili resim üzerinde 
özgün bazı efektler uygulanmasını sağlar. 

Noise: Seçili resme noise etkisinin verilmesini veya 
varolan noise etkisinin kaldırılmasını sağlar. 

Plugins: Bilgisayara yüklenmiş olan harici bazı 
programların corel sayfasında seçili resim üzerinde etkili 
olmasını sağlar (KPT, Eye Candy…). 

Effects (Efektler) Menüsü 

Convert to Bitmap: Seçili nesnenin resme çevrilmesini 
sağlar 
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Edit Bitmap: Seçili resmin Corel Photo Paint 
programında düzenlenmesini sağlar 

Crop Bitmap: Seçili resmin kesilmesini sağlar (Burada 
Crop Bitmap butonu aktif değildir, kesme işlemi “Shape 
Tool” (F10) aracıyla yapılır) 

Trace Bitmap: Seçili resmin Corel Trace programında 
vektörel çizime dönüştürülmesini sağlar 

Resample: Seçili resmin yatay ve(ya) yatay düzlemde 
yeniden ölçülendirilmesini ve çözünürlüğünün yeniden 
ayarlanmasını sağlar. 

Mode: Seçili resmin hangi renk kanalında olduğunu 
gösterir ve sahip olduğu renk kanalının değiştirilmesini 
sağlar. 

Inflate Bitmap: Seçili resmin sayfa içerisinde resim 
olarak kapladığı ölçünün değiştirilmesini sağlar Bitmap. 

Color Mask: Seçili resim üzerinde atanacak bir renk 
üzerinden bir maske uygulamasının yapılmasını sağlar. 

Resolve Link: Seçili resme harici bir kaynağa link, 
bağlantı verilmesi ile ilgili düzenlemeler yapar. 

Update From Link: Seçili resme verilen bağlantının 
güncelleştirilmesini sağlar 

3D Effects: Seçil resme üç boyutlu efektler verilmesini 
sağlar 
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Art Strokes: Seçili resmin zeminine dolgu efektlerinin 
uygulanmasını sağlar 

Blur: Seçili resim üzerinde resmin görüntüsünde bulanık 
etkisinin oluşturulmasını sağlar. 

Camera: Seçili resim üzerinde kameralarda bulunan 
noise etkisinin oluşmasını sağlar. 

Color Transform: Seçili resim üzerinde sahip olduğu 
renk kanallarıyla oynayarak nokta bazında yeni görünüm 
almasını sağlar. 

Contour: Seçili resmin piksellerini baz alarak piksellerin 
etrafında değişiklik yapıp resmin yeni bir görünüm 
almasını sağlar. 

Creative / Distort / Sharpen: Seçili resim üzerinde 
özgün bazı efektler uygulanmasını sağlar. 

Noise: Seçili resme noise etkisinin verilmesini veya 
varolan noise etkisinin kaldırılmasını sağlar. 

Plugins: Bilgisayara yüklenmiş olan harici bazı 
programların corel sayfasında seçili resim üzerinde etkili 
olmasını sağlar (KPT, Eye Candy…). 

4.2.8. Text Menüsü (Yazı)  

Format Text (Ctrl+T): Corel sayfasında seçili yazı 
ve(ya) yazı gruplarının ayrıntılı özelliklerinin 
düzenlenmesini sağlar. 
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Edit Text (Ctrl+Shift+T): Seçili yazı ve(ya) yazı 
grubunun basit özelliklerinin düzenlenmesini sağlar. 

Insert Character (Ctrl+F11): Yazı ve(ya) yazı grubuna 
özel veya basit yazı karakterlerinin eklenmesini sağlar. 

Fit Text to Path: Seçili yazı ve(ya) yazı grubunun seçili 
olan bir şekil veya çizgi etrafına yerleştirilmesini sağlar. 

Fit Text to Frame: Phragraph Text düzeninde olan 
yazıların yazı alanına otomatik olarak yerleştirilmesini 
sağlar. 

Align to Baseline: Tek bir satırda yer alan yazıların satır 
boyunca düzensiz olan eğimini düzeltir. 

Straighten Text: Fit text to path yöntemiyle şekli 
değiştirilen yazıyı tekrar düzgün haline çevirir. 

Writing Tools: Seçili yazı üzerinde şu düzenlemeleri 
yapar. 

Spell Check (Ctrl+F12): Seçili yazı grubunun heceleme 
işlemini gerçekleştirir. 

Grammatik: Seçili yazı grubundaki yazım hatalarını 
denetler. 

Thesaurus: Seçili yazı grubunda yazılı kelimelerin 
anlamların açılandığı bir pencere açar. 

Quick Correct: Yanlış yazılan bazı kelimelerin otomatik 
olarak düzeltilmesini sağlar. 
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Language: Yazım denetiminde hangi dilin seçili 
olacağını belirler. 

Settings: Yazım işlemleri ile ilgili ayarların yapılmasını 
sağlar. 

Change Case: Seçili kelimelerde harflerin büyük veya 
küçük harf olmasını sağlar. 

Make Text Web Compatible: Paragraf Text yazı 
konumundaki yazıların internet ortamında kullanılmak 
üzere özelliklerini geliştirir. 

Convert (Ctrl+F8): Pharagraph Text düzenindeki yazıyı 
Artistic Text konumuna, Artistic Text düzenindeki yazıyı 
da Phargraph Text düzenine çevirir. 

Text Statistics: Corel sayfasında bulunan yazıların 
istatistiki bilgilerini verir. 

Show Non-Printing Characters: Yazıcılar tarafından 
basılamayacak özel karakterlerin gösterilmesini sağlar. 

Link / Unlink: Yazılara harici bir kaynağa bağlantı 
verilmesini veya kaldırılmasını sağlar. 

Tools (Araçlar) Menüsü  

Options (Ctrl+J): Corel programının ayarlarının 
yapıldığı menüyü açar. 

Customization: Corel programını kişiye göre 
özelleştirilmesinin nasıl yapılacağını açıklar (İngilizce). 
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Color Management: Üzerinde çalışılan dosyanın hangi 
amaçla kullanılacağını tayin edip uygun renk profillerinin 
kullanılmasını sağlar. 

Save Settings As Default: Corel programı ile ilgili 
yapılan tüm ayarlamaların varsayılan ayarlar olarak 
kaydedilmesini sağlar. 

Object Manager: Corel çalışmasında kullanılan tüm 
nesnelerin özelliklerini ayrıntılı bir şekilde açıklayan bir 
pencere açar. 

Object Data Manager: Corel programının içinde 
kullanılacak verilerin düzenlemesiyle ilgili bir pencere 
açar (Bu bölümü kullanabilmek için Visual Basic ve 
programcılık bilgisi gerekmektedir). 

View Manager: Corel sayfasının ekran görünümü ile 
ilgili düzenlemelerin yapılacağı bir pencere açar. 

Link Manager: Corel sayfasında verilen bağlantıların 
özelliklerini gösteren bir pencere açar. 

Undo Docker: Corel sayfasında son yapılan işlemlerin 
listesini sıralayan bir pencere açar. 

Internet Bookmark Manager: Corel sayfasından 
bağlantı verilen sayfaların listesini veren bir pencere 
açar. 

Color Styles: Corel sayfasında tanımlı özel renklerin 
saklandığı bir pencere açar. 
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Palette Editor: Corel programında kullanılan renklerin 
özellikleri ve tanımlı isimleri ilgili düzenlemelerin 
yapıldığı bir pencere açar. 

Graphic and Text Styles: Corel çalışmasında kullanılan 
grafik ve yazıların biçimleri ile ilgili bilgilerin yer aldığı 
bir pencere açar. 

Scrapbook: Corel programının direkt açabileceği veya 
import edebileceği tüm kaynaklara kısa yoldan ulaşmayı 
sağlayan bir pencere açar. 

Create: Corel programının içine kullanıcının tanımlamış 
olduğu çizim, pattern renkleri ve özel karakterler 
oluşturulmasını sağlar. 

Run Script: Corel programında bazı özel uygulamaları 
çalıştırmak için oluşturulmuş scriptlerin çalışmasını 
sağlar. 

Visual Basic: Corel programında Visual Basic programı 
ile geliştirilen bazı hazır uygulamaların çalıştırılması, 
değiştirilmesi gibi özelliklerin kullanılmasını sağlar 
(örneğin hazır takvim uygulaması, renk sakalası 
oluşturma…). 

4.2.9. Window (Pencereler) Menüsü  

New Window: Corel programında yeni bir pencere 
içinde yeni bir çalışma sayfası açar. 
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Cascade: Corel programında açık olan pencerelerin, 
çalışma sayfalarının sıralı halde hepsini birden gösterir. 

Tile Horizantally: Corel programında açık olan çalışma 
sayfalarının hepsinin yatay olarak sıralanmasını sağlar. 

Tile Vertically: Corel programında açık olan çalışma 
sayfalarının hepsinin dikey olarak sıralanmasını sağlar.  

Color Palettes: Corel çalışmasında hangi renk 
profillerinin kullanılacağının belirlenmesini sağlar. 

Dockers: Corel programında sağ tarafta hangi “tools” 
menülerinin görüntüleneceğinin belirlenmesini sağlar. 

Close (Ctrl+F4): Corel programında açık olan çalışma 
sayfanın kapanmasını sağlar. 

Close All: Corel programında açık olan bütün çalışma 
sayfalarının kapanmasını sağlar.  

Re.freshWindow (Ctrl+W): Özellikle ekran 
kartlarından kaynaklanan görüntü kayıplarının yok 
edilmesi için ekran görüntüsünün tazelenmesini sağlar. 
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BEŞİNCİ BÖLÜM 

5. UYGULAMALAR 

UYGULAMA 1: RECTANGLE TOOL (F6) 

Klavye'den F6 tuşlayın Soldaki Tool Box kutusunda 
Regtangle Tool )  

Klavye'den Ctrl tuşuna basılı tutarak çizdiğinizde tam bir 
kare çizebilirsiniz.  Sayfa UYGULAMAnızın herhangi 
bir noktasına mause'u basılı tutarak sağa ve aşağı yada 
yukarı doğru çekiniz. Ctrl tuşunu bırakıp çizdiğinizde 
dilediğiniz gibi bir dikdörtgen çizebilirsiniz. Eğer 
dikdörtgenden vazgeçerseniz yine Ctrl'e basılı tutun.  
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UYGULAMA 2:ELLIPS TOOL (F7) 

Klavye'den Ctrl tuşuna basılı tutarak çizdiğinizde tam bir 
daire çizebilirsiniz.  Sayfanızın herhangi bir noktasına 
mause'u basılı tutarak sağa ve aşağı yada yukarı doğru 
çekerseniz eğer elips çizebilirsiniz. 

(Pie) Pasta Dilimi Çizmek  

 

1. starting angle 3.  
2. ending angle 1. ve 2. Pasta diliminin başlangıç ve 

bitiş noktalarını yazarız. 

3. Yazdığımız başlangıç ve bitiş açılarının yerlerini 
değiştirebiliriz. Aynı zamanda sağ yada sol 
butonuna basıp elinizi kaldırmadan değişikliği 
izleyiniz. 
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UYGULAMA3: POLYGON TOOL (Y) (ÇOKGEN 
ÇİZMEK):  
 

 
 
SHIFT e basarsak her yanı eşit oranda büyüyecektir. 
Çokgen çizerken bir yandan da CRTL tuşuna basarsanız 
çokgeniniz eşkenar olur. 
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UYGULAMA 4: SPİRAL (A) ÇİZMEK 
 

 
 

 
 
 
 
 
 
 
 
 
UYGULAMA 5: DÖRTGEN GRUBUNDAN 
OLUŞAN BİR TABLO ÇİZMEK 
 

 
 
 
 

 

 

Tablo gözlerini birbirinden bağımsız hale getirmek için 
Arrange menüsünden Ungroup seçeneğini seçerek 
tablonun gözlerini birbirinden ayırabiliriz. 
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UYGULAMA6: KESME, BİRLEŞTİRME, KESİŞEN 
BÖLGELER 

Kare veya dikdörtgen çizelim (F6). Ardından (F7) 'i 
tuşlayın. Herhangi bir yere daire veya elips çizin. Soldaki 
Tool Box'ta; en üstteki, mause'u tıklayın.  

Bu açtığımız daire ve kareyi kesişecek şekilde yerleştirin. 
Dairenin çizgisine tıklayıp, basılı tutarak istediğiniz 
konuma getirin. Şimdi burada ne yapmak istiyoruz, 
bulalım. Yuvarlağı kareye mi kestirelim. Hazırladığımız 
nesnelerden hiçbiri seçili olmasın. Klavye'den Esc'i 
tuşlayın. Yada mause ile sayfada herhangi bir yerine 
click'leyin. İlk önce yuvarlağı seçili hale getirelim. Shift 
tuşuna basılı tutarken, kare'yede tıklayalım. ( Seçelim ) 

 

 
      1 2 3 4 5 6 7  

 

 

 

WELD  
Weld birleştirme 
komutu 2 veya daha 
fazla bileşenden tek 
bir eğri oluşturur. 
Bileşenler üst üste 
gelebilir, yan yana 
oturabilir veya 
birbirinden uzak bir 
mesafe olabilir. 
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TRIM 

Trim komutu 2 veya 
daha fazla bileşenden 
tek bir eğri oluşturur. 
Bileşenler üst üste 
gelmelidir. Kırpma, 
seçili nesnenin 
(Kaynak Nesne) 
şeklini, örtüştüğünüz 
yere kırptığınız 
nesneye dönüştürür. 
(Hedef Nesne). 

 

 

 

INTERSECT 

Kesişim, 2 bileşenin 
çakışmasıyla oluşan 
şekli oluşturur. 
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UYGULAMA7: DAİRE VEYA HERHANGİ BİR 
PATH’İN ETRAFINI SARAN YAZI  

Aşağıda gördüğümüz metni (ya da herhangi bir metni) 
bir daire ya da çizimin etrafına yazmak için.  

1- Şekli hazırlayınız 
2- Yazıyı yazınız.  
3- Yazıyı seçtikten 

sonra üstteki  
Text menüsünden 
Text > Fit to Text Path 
seçeneğini işaretleyerek dairenin etrafına yazının 
sarmasını sağlarız. Mesafe için çıkan oku 
etrafında döndürerek istediğiniz konuma 
geldiğinde bırakabilirsiniz. 

 

Tekrar iki şekli 
ayırmak için; 

 Arrange > Break 
Text Appart 

komutunu kullanıp iki 
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nesneyi ayırır veya  

Text > Straighten Text komutu ile de yazıyı eski haline 
döndürebiliriz. 

Yine üstteki menü çubuğunda kullandığımız özellikle 
ilgili yardımcı diğer unsurlar aktif hale gelecektir ve 

yaptığınız çalışmanın üzerinde değişiklik yapmanız 
mümkün olacaktır.  

1- Hazır efektler   
2- Çizgi ile hizalama  
3- Daire ya da nesnenin alt üst ya da yanlarına 

yazma  
4- Nesne ile arasındaki mesafe  
5- Nesnenin orjin noktası ile arasındaki mesafe  
6- Yazıyı ters döndürme için kullanacağınız 

efektlerdir. 
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UYGULAMA 8: Freehand Toll aracını kullanmak  

 

Freehand Toll aracı kendimize has nesneler 
çizmemiz için kullandığımız bir araçtır.  

Boş bir sayfa açtıktan sonra ToolBox dan Freehand 
Tool'u seçiyoruz. Tıpkı bir kalemle kağıda çizim yapar 
gibi dilediğiniz herşeyi kolayca çizmenize yardımcı olan 
bu seçenek oldukça aktif kullanılmaktadır. 

 

Şimdi sayfada boş bir yere tıkladıktan sonra fareye basılı 
tutmadan imleci sürükleyin ve düz bir çizgi çizin. Sonra 
şeklinizi oluşturmak için çizginize nokta ekleyin; ama bu 
sefer çift tıklama yaparak ilerleyin. Eğer ucu kapalı bir 
alan çizip içine dolgu rengi vermek istiyorsanız uç uca 
getirerek birleştirin.  

ÖNEMLİ NOT:Çizginin birleşip 
birleşmediğini anlamak için menü 
çubuğunun üzerinde görebileceğiniz “Close 
Curve” aracına bakın ortasında kırmızı 

artıyı görüyorsanız çizginin birleşmediğini 
anlayabilirsiniz. Close Curve seçtiğinizde artık 
çizgileriniz kapalı bir alan olacaktır.  
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UYGULAMA 9: HAZIR ŞEKİLLER 

 

 

 

Bu seçenekte bazı temel şekilleri otomatik olarak 
sayfamıza aktarır ve özelliklerini belirleyebiliriz.  

- Aşağıdaki özelliklere sahip şekli çiziniz. Basic Shapes 
içerisinde kullanabileceğiniz hazır şekiller 
bulunmaktadır. 
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UYGULAMA 10: Çizgi ve Eğri Çizmek 

Serbest çizimleriniz için Freehand ve Bezier araçlarını 
kullanabilirsiniz. 

 

8 farklı özelliği içermekte sizde 8 ayrı özellikle ilgili 8 
farklı çalışma yapınız. 

Uygulama :Artistic media yüzey çizmek çizgileri yüzeye 
dönüştürmek:  

Preset: Bu araç belirli 
şekillerde ve çizgin 
eğitiminde yüzeyler 
çizmemizi sağlar. Öncelikle 
Property Bar üzerinde 
Smoothing  bölümünde 
yumuşatma miktarını 
ayarlayın daha sonra  
Artistic Media Tool Width  
bölümünde çizeceğiniz 
yüzeyin maksimum kalınlığını 
belirleyin. Preset listesinden bir 
yüzey seçin. Ve sayfa üzerinde 
istediğiniz yere çizin. Artık bu 
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yüzeyin dolgu ve kontur özelliklerini değiştirebilirsiniz. 

Brush:  Çizgiyi Brush aracını 
seçtikten sonra çizeceksiniz. 
Brush Stroke List bölümünden 
istediğinizi seçebilirsiniz. Burada 
dikkat edeceğiniz şey 
yumuşatma ve kalınlığı önceden 
belirlemeniz sonrada 
değiştiremezsiniz. 

Image sprayer:  Serbest bir 
çizimi kütüphaneden seçeceğiniz herhangi bir desene 
dönüştürebilirsiniz. 

 

 

 

 

 

 

 

 

 

Hangi sırayla gelmesini belirlemek istersek; 
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UYGULAMA 11. CONVERT TO CURVES 

 

CORELDE GEOMETRİK ŞEKİLLERİ 
DÖNÜŞTÜRMEK 

Convert To Curves Komutunu Şekiller Üzerinde 
Kullanmak 

Bu komut sayesinde poligon araçları ile çizilmiş bir 
nesnenin dış hat sınırlarını değiştirebiliriz. Aşağıda 
çizilmiş olan bir dikdörtgenin Köşelerinin eğilme 
biçimleri gösterilmiştir. Eğer dikdörtgenimize 
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Arrange>Convert To Curves komutu uygulanmazsa 
Shape Tool (biçim aracı) ile Köşelerinde tutularak 
oynanırsa dikdörtgenimiz köşelerinde kavisler 
oluşacaktır. Fakat komut verilerek uygulanırsa sadece 
tutulmuş olan köşenin değiştiği görülecektir. 

UYGULAMA 12: CONVERT TO CURVES  

COREL‟DE YAZILARI DÖNÜŞTÜRMEK 

Eğer Corel Draw'la çalışıyorsanız ve yaptığınız işlerin 
filmlerini aldırıp matbaadan çıktı almak istiyorsanız, 
kendi bilgisayarınızda yaptığınız işi film çıktısı alan 
firmaya götürdüğünde, sizin işinizi kendi bilgisayarında 
açacak ve eğer sizin tasarımda kullandığınız yazı fontları 
onun bilgisayarında yoksa, (Corel bilgisayarda olmayan 
fontu tanımaz) Corel 
kendi fontlarından 
rasgele birisini sizin 
fontlarınıza atar ve 
aldırdığınız film boşa 
gidebilir.  Bunu önlemek 
için öncelikle önerimiz 
yaptığınız işi pdf olarak 
matbaa’ya götürmeniz 
veya  tüm text 
yazılarınızı “convert to 
curves” komutu ile 
Convertlemenizi öneririz. Ancak bu işlemi yaparken text 
halinin olduğu klasörünüzü arşivlemeyi unutmayınız. 
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Edit > Select All > Text komutunu veriniz. Bu tüm 
sayfadaki yazıların tamamını seçecektir.  Daha Sonra 
Text'ler seçili iken  

Arrange > Convert to curves komutunu veriniz. Eğer 
Text yazılarınızı gruplandırdıysanız textleriniz Convert 
edilemez. 

Yazılmış olan artistic text yazısı üzerinde Convert To 
Curves uygulandığı zaman değişik grafik tasarımlarında 
ve amblem, logo tasarımlarında yararlanabileceğimiz 
özellikler gerçekleşecektir. 

Yazılmış olan yazımız üzerinde değişiklikler yapmak 
istiyorsak. Metin seçili iken Convert To Curves denilirse 
metinde bulunan harflerimizin etraflarında tutma 
noktaları belirecektir. Shape Tool (biçim aracı) yardımı 
ile bu tutma noktalarından harflerimizin Şekillerini 
değiştirebilir, üzerlerinde oynayabiliriz. 
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UYGULAMA 13: ADD PERSPECTIVE 

COREL DRAW'DA NESNELERE PERSPEKTİF 
VERMEK 

Programda boş bir sayfa açalım ve boş sayfa üzerine bir 
yazı veya şekil ekleyelim. 

Daha sonra Effect > Add Perspective komutunu 
verelim.   

Sıra perspektifi 
vermeye geldi. 
Gördüğünüz gibi 
"Add Perspective" 
komutunu 
verdiğimizde 
yazının dört yanında 
perspektif 
tutamaçlar (kırmızı) görünür. Bu tutamaçlar yardımı ile 
yazımıza istediğimiz perspektifi kazandırabiliriz. 
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UYGULAMA 14: BLEND TOOL 

Objeler arasında şekil ve renk geçişi yapar. Bu işlemi 
yapmak için en az 2 obje kullanılmalıdır. Komutu alıp, 
bir objeye basılı tutup, diğerinde bırakmanız 
gerekmektedir. Menüden kullanacaksak iki objeyi tutup 
blend komutuna basmamız gerekecektir. 

 

 

 

 

 

 

UYGULAMA 15:CONTOUR TOOLS 

CONTOUR KOMUTLARI İLE YAZILAR 

Text ile yazmak istediğiniz bir şey 
yazın ve tools araç paletinden 
effectlere gelin.  

Text yazın. Soldaki Tool Box'tan en 
üstteki mause'a tıklayalım. Font size 
“(punto) 60” Font'umuz “Bauhaus” 
Renginizi “yeşil” seçin. Daha sonra 
istediğiniz rengi seçebilirsiniz.  
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Yazınız seçiliyken resimdeki Contour Effect'ini 
seçelim.  Property Bar, Contour Efect'imizin ayarlarını 
getirdi.   

 

1. numaralı bölge Effect'i merkeze uygulamadır. 
2. numaralı bölge Effect'i içeri uygulamadır. 
3. numaralı bölge Effect'i dışarı uygulamadır. Bu 

uygulamayı seçelim.  
4. numaralı bölge Effect'in adım sayısıdır. 4 yapın  
5. numaralı bölge Effect'in adım sayılarının 

milimetrik olarak genişlik değeridir. 1 mm. yapın. 
6. numaralı bölge Effect'i eğer yazımızın kenarına 

çizgi kalınlığı uyguladıysak Contour'daki renk 
değeridir.  

7. numaralı bölge Effect 'in renk uygulamasıdır. Bir 
renk seçin.  

Contour ile başlayarak geliştirilmiş birkaç uygulama.  

 

 

1 2 3 4 5 6 7
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UYGULAMA 16: Distort (Etkileşimli Distorsiyon 
Aracı ) 

Etkileşimli Distorsiyon Aracı. Bu araç nesnelerin 
anahatlarını bozar. Dikkatsiz uygulandığında, nesnelerin 
şeklini tamamen değiştirir, ancak ince uygulandığında, 
nesnelerin daha az geometrik görünmesini sağlayabilir ve 
daha doğal görünebilir. Bunu kullanmak için, aktif 
özellik çubuğundan bir tür bozulma seçin ve distorsiyonu 
uygulamak istediğiniz nesneyi tıklatın ve sürükleyin. 

Distort seçeneğini tıkladığınızda property araç 
çubuğunda alttaki menü aktif hale gelecektir. Yapmak 
istediğiniz özelliği uygulayabilirsiniz. 
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UYGULAMA 17: Envelope  (Nesne Eğip Bükme). 

1. Bir text yazın. Font size 
(points) 30 font  : arial + bold.  

2. Daha sonra text seçili iken 
Envelope’u tıklayın ve 
aktiflenen noktalardan 
istediğiniz şekli verin. 

Şekilde görüldüğü gibi Envelope 
özelliği   

Kenar ve orta noktaları seçmemizi ve 

müdahele edebilmemizi sağlayacaktır. Ayrıca Mavi 
noktaları shape tool ile aktif hale getirdikten sonra 
üzerine istediğiniz kadar nokta ilave edebiliriniz. 
(çizginin üzerine çift tıklarsanız + nokta ilave edebilir, 
tekrar çift tıkladığınızda - silebilirsiniz. ) 

UYGULAMA 18: DROP 
SHADOW 

Objelerimize gölge vermeye 
yarar. Dropshadow komutunu 
tıklayın ve gölge vermek 
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istediğiniz objeyi seçin. Herhangi bir alanını basılı tutup 
dışarı doğru çektiğinizde gölge oluşturabilirsiniz veya bu 
seçeneği tıkladığınızda property bar çubuğunda aktf hale 
gelen seçeneklerden de yararlanabilirsiniz. 

UYGULAMA 19:  EXTRUDE 

Objelere derinlik vererek, üç boyutlu görüntü 
oluşturmamıza yarar. 

Objemiz seçili iken Extrude seçeneğini tıklayalın. 
Objenin üzerine basılı tutup geriye doğru itin. 
Özelliklerini görmek için yine bu seçenek seçili iken 
property bar üzerinde uyguladığınız özelliğe ait diğer 
özellikler aktif olacktır. Buradan dilediğiniz değişiklikleri 
yapabilirsiniz. 
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UYGULAMA 20: TRANSPARENCY 

Objelere ve fotoğraflara şeffaflık vermemizi sağlar. 
Şeffaflık vereceğimiz objeyi veya fotoğrafı sayfamıza 
çizelim veya aktaralım. Transparency seçeneğini 
tıklayalım ve property bar üzerinde aktif olan none yazan 
menüden “uniform” u seçelim bu seçenek tüm yüzeye 
eşit olarak şeffaflık vermenizi sağlar. “Linear”’da ise 
objenin bir kısmının şeffaf olmasını sağlarız. 

Obje üzerinde çıkan ok ve üzerindeki kaydırma çubuğu 
ile bu şeffaflığın yönünü ve yoğunluğunu artırıp 
azaltabiliriz. 
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UYGULAMA 21: POWERCLIP 

Nesnelerimizi Belirlediğimiz bir obje içerisinde 
saklamamıza yarar. Bir yazınız, bir fotoğrafın veya bir 
objenin görünmesini istediğimiz yüzeylerini, çizdiğimiz 
bir path içerisine veya hazır olan bir objenin içerisine 
aktarabiliriz. Özellikle afiş ve broşür çalışmalarında 
çerçeve özelliklerini de ayarlayarak görsellerin 
sınıflandırılmasında oldukça fazla kullanılan bir 
özelliktir. Aynı zamanda Text yazısının içerisinde de 
istediğiniz görselleri saklayabilirsiniz. 
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İlk olarak; PowerClip adı, iki nesnenin üst üste geldiği 
bir durumda bir nesnenin diğerinin sınırlarını kesmesi ya 
da kırpması işleminden gelir. PowerClip efektinde bir 
nesne taşıyıcı (container) görevi üstlenirken, diğeri ya da 
diğerleri içerik (content) haline gelir.  

Özelliğin kullanılabilmesi için taşıyıcı bir nesne açmamız 
gerekmektedir. Bunun için sınırları kapalı herhangi bir 
nesne seçebiliriz. Sayfa mizanpajımızda kullanmak 
istediğimiz alana göre bu nesnemizi açabiliriz. Bu bir 
kare, dikdörtgen, yıldız, dair ya da elips olabilir. Bu 
nesnemizin içine yerleştireceğimiz resmimizide 
sayfamıza çağırırız.  
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Text Örneği 

Yapmış olduğumuz PowerClip çalışması üzerinde 
değişiklikler yapabiliriz. Bunun için PowerClip yapılmış 
resmimiz üzerine gelerek faremizin sağ tuşuna basarak 
buradan Edit Contents seçeneğini işaretlememiz gerekir. 
İşaretlendiği zaman üzerinde değişiklik yapmamıza 
imkân verecektir. Burada gömülü resmimizi büyültüp 
küçültebilir ya da resmimizin neresinin nesne içinde 
görünmesini istiyorsak buradan ayarlayabiliriz. 

UYGULAMA 22: Paragraph Text 

Burada metin alanının şekli konusunda sınırlar ortadan 
kaldırılmıştır. Herhangi bir kapalı nesne çizip text aracını 
bu nesnenin içine tıkladığımız zaman çizilmiş olan 
nesnenin şekline göre metin alanı otomatik olarak 
açılacaktır. 
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Hyphenation (tireleme) terimi, satır sonundaki uzun 
sözcüklerin bir tire ile bölünerek bir sonraki satırda 
devam etmesini anlatmak için kullanılır. Bu özelliği 
kullanmazsanız cümlelerdeki uzun sözcükleri bir sonraki 
satıra atlayarak satır sonlarında uzun boşluklar 
oluşturabilir. Tireleme özelliğini kullanmak, daha fazla 
bütünlüklü ve etkileyici bir sayfa düzeni oluşturmanıza 
imkân vererek satırların sonundaki boşlukların sayısını 
azaltmanıza ve satırları birbiriyle uyumlu kılmak için 
gerekli olan boşluk miktarını en aza indirmenize 
yardımcı olur.  

Paragraph Textte Metin Alanı Cetvel Ayarları 

Bir metin alanı açıldığı zaman otomatik olarak cetvel 
üzerinde bazı araçlar belirir. Bu araçlar yardımı ile 
paragraf başını, metnin sol ve sağ girinti ayarlarını 
yapabiliriz. 
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Diğer bir alt başlık olan columns (sütunlar) penceresi 
yardımı ile yazılı metnimizin ya da yazılacak metnin kaç 
sütundan oluşacağını, sütunlar arasındaki boşlukları ve 
ayarları gerçekleştirebiliriz. Ön izleme penceresi yardımı 
ile işlemi metne uygulamadan görebiliriz. 

 

 

 

 

 

 

 

 

Effects (efektler) alt başlığı altında ise Bullet (madde 
işaretleri) belirleyebilir, Drop (*İnisyal) özelliği ile 
metinlerimizin ilk harflerini efektlerle süsleyebiliriz. 
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UYGULAMA 23:BREAK CURVE APART 

CorelDRAW yazısını Convert to Curves’e tıkladığımızda 
Convertleme işlemi yaparız bu işlem text’imizi Şekil 
haline dönüştürecektir. Üzerinde işlem yapabilmek için 
Break Curve Apart’ı seçtiğimizde harflerin ayrılan 
katmanları belirir Ungroup işlemi yaptığımızda ise tüm 
harfler Shape Tool ile müdahale debiliriz. Yalnız 
unutmamalıdır ki Şekle dönüşen harfler katmanlara 
ayrılır ve Örneğin A harfini önce text olarak yazıp 
sonrasında Convert işlemi yaptığımızda içinde içinde bir 
üçgen ile bir anahat şekli içerir. Dolgu, üçgeni çevreler 
ancak üçgenin kendisi doldurulmaz. Şimdi text aracını 
kullanarak A harfini çizin. Açıkça görebileceğiniz bir 
boyuta büyütürseniz yardımcı olabilir. Text’, Convert to 
curves’li eğrilere dönüştür. Seçilen nesne ile ekranın 
altındaki durum çubuğuna bakın. Size bir eğri olduğunu 
söyleyecektir. Şimdi eğriyi birbirinden ayırın 
(BreakCurve Apart'ı düzenleyin) ve dolguya ne olduğunu 
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ve durum çubuğunun size ne söylediğini fark edin. Artık 
2 objemiz var. Üçgen kendi içinde bir eğri olduğundan, 
şimdi kendi dolgusu vardır. Şimdi tekrar birleştirin 
(Birleştir'i Düzenle) ve önceki harf A'yı göreceksiniz. 

 

UYGULAMA 24: MACRO İLE TAKVİM YAPMAK 

Coreldraw programının 
tasarımcılara sunduğu en 
güzel özelliklerinden 
biridir. Bu sayede 
mümkün olan en kısa 
zamanda bir takvim 
oluşturmanız mümkün. 

Bunun için  

Tools > Macros > Run 
Macro komutunu 
tıklayalım. 

Açılan pencerede macros in açılır penceresinden 
Calender Wizard’ı seçelim ve RUN komutunu 
tıklayalım. Açılan pencerede year kısmından yılı ve 
ayları girelim. Dilerseniz ALLseçeneği ile tüm ayları 
seçebilirsiniz. Language sekmesinden takvimin dilini 



94 

 

belirleyelim. Ancak diller arasında muhtemelen Türkçe 
olmayacaktır. Bunun içinse Language sekmesinden New 
butonunu tıklayalım ve TÜRKÇE yazalım. Ardından 
açılan pencerede Months sekmesinden ayların Türkçe 
karşılıklarını yazalım. Days of week ile günlerin Türkçe 
karşılıklarını yazalım Short Form’a ise günlerin 
kısaltılmış karşılıklarını yazalım. Default Character set 
sekmesinden Turksih’i seçelim ve Add > Modify 
komutuna basarak dilimizi listemize ekleyelim. Ardından 
Close’a basarak çıkalım. Artık Language bölümündeki 
listeden Türkçe seçeneğini seçerek dil seçimini 
yapabiliriz.  
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Week stars on sekmesinden haftanın başlangıç gününü 
seçelim. Bizim başlangıç günümüz Pazartesi olduğu için 
Monday’i seçelim. Varsa Holidays sekmesinden özel 

günlerimizi, tatil günlerimizi de tanımlayabiliriz. Layout 
bölümünden takvimimizin ara yüzünü hazır şablonlardan 
seçerek belirleyebiliriz. İsterseniz yazı tipini ve rengini 
değiştirebilirsiniz İşleminizi tamamladıktan sonra 
Generate butonuna basarsanız takviminizin hazır 
olduğunu görebilirisiniz. Dilerseniz üzerinde değişiklik 
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yapmak, görsel eklemek için Ungroup ile takvimi 
çözebilir ve renklerini değiştirebiliriz.  
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Eğitim Programı, Ekim 2005. G.Ü. Beltek Projesi 
kapsamında 2005-2018 yılları arasında Beltek projesi 
kapsamında “Coreldrawla Grafik Tasarım” dersini 
verdi.2013 yılında 4th International Conference on Power 
Engineering, Energy and Electrical Drives projesinde yer 
aldı. 2013 yılında Gazi Üniversitesi Gazi Meslek 
Yüksekokulu Logosunu tasarladı.2014 yılında MEB ile 
birlikte Gazi Üniversitesi, Yıldırım Beyazıt Üniversitesi 
ve Çubuk Belediye Başkanlığı'nın ortak bir projesi olarak 
gerçekleştirilen  "Bu Öykünün Kahramanı Benim" adlı 
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kitap projesinde grafik tasarım ve sayfa tasarımı yapmak 
üzere görev aldı.Gazi Üniversitesi Polatlı Sosyal Bilimler 
MYO' unda Ağustos 2016- Ağustos 2018 tarihleri 
arasında Polatlı Sosyal Bilimler Meslek Yüksekokulu 
Müdür Yardımcılığı görevi yaptı.Ağustos 2018 
tarihinden itibaren Polatlı Teknik Bilimler MYO Müdür 
Yardımcılığı görevini Ekim-2018 tarihine kadar yerine 
getirdi.2018 yılında üniversitelerin bölünmesi sonrasında 
"Ankara Hacı Bayramı Veli Üniversitesi Görsel İşitsel 
Teknikler ve Medya Yapımcılığı" Bölümünde Öğretim 
Görevlisi olarak görevine devam etmektedir. Aynı 
zamanda "Anadolu Üniversitesi Halkla İlişkiler ve 
Reklamcılık" "Lisans" öğrenimine devam etmektedir. 

 




	önkpk
	içindekiler2
	Corel Draw’a Başlarken 18

	GİRİŞ._SAYFA NUMARALI (1)
	GİRİŞ
	Corel Draw’a Başlarken

	arkkpk

